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Preface

Preface

Thank you for purchasing this Topcon product. The materials
available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon
products, and are designed to assist owners with the use of the
receiver and its use is subject to these terms and conditions (the
“Terms and Conditions”).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user
should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local
government protection agency for both private use and commercial
job sites.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your receiver. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by TPS.
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Preface

TRADEMARKS GR-3™, Topcon Tools™, Topcon Link™,
TopSURV™, Modem-TPS™, Topcon® and Topcon Positioning
Systems™ are trademarks or registered trademarks of TPS.
Windows® is a registered trademark of Microsoft Corporation. The
Bluetooth® word mark and logos are owned by Bluetooth SIG, Inc.
and any use of such marks by Topcon Positioning Systems, Inc. is
used under license. Other product and company names mentioned
herein may be trademarks of their respective owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT
BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE
FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL
OR THE RECEIVER. SUCH DISCLAIMED DAMAGES
INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS
OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION
TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR
COSTS INCURRED IN CONNECTION WITH OBTAINING
SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY
OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY
EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY
IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.

LICENSE AGREEMENT Use of any computer programs or software
supplied by TPS or downloaded from a TPS website (the “Software”)
in connection with the receiver constitutes acceptance of these Terms
and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive,
non-transferable license to use such Software under the terms stated
herein and in any case only with a single receiver or single computer.
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Terms and Conditions

You may not assign or transfer the Software or this license without
the express written consent of TPS. This license is effective until
terminated. You may terminate the license at any time by destroying
the Software and Manual. TPS may terminate the license if you fail to
comply with any of the Terms or Conditions. You agree to destroy the
Software and manual upon termination of your use of the receiver. All
ownership, copyright and other intellectual property rights in and to
the Software belong to TPS. If these license terms are not acceptable,
return any unused software and manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential
Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade
secrets. Nothing in this paragraph shall restrict you from disclosing
Confidential Information to your employees as may be necessary or
appropriate to operate or care for the receiver. Such employees must
also keep the Confidentiality Information confidential. In the event you
become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
TPS website (or any other website) or in any other advertisements or
TPS literature or made by an employee or independent contractor of
TPS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability).

SAFETY Improper use of the receiver can lead to injury to persons or
property and/or malfunction of the product. The receiver should only
be repaired by authorized TPS warranty service centers. Users should
review and heed the safety warnings in an Appendix.

MISCELLANEOUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in
accordance with, the laws of the State of California, without reference
to conflict of laws.
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Manual Conventions

This manual uses the following conventions:
Example Description

File » Exit Click the File menu and click Exit.
Connection Indicates the name of a dialog box or screen.

Frequency Indicates a field on a dialog box or screen, or a tab
within a dialog box or screen.

Enter Press or click the button or key labeled Enter.

Further information to note about the configuration,
maintenance, or setup of a system.

Supplementary information that can help you
configure, maintain, or set up a system.

measurements, or personal safety.

Notification that an action has the potential to
adversely affect system operation, system

Supplementary information that can have an affect
@ on system operation, system performance,
@ performance, data integrity, or personal health.

Notification that an action will result in system
damage, loss of data, loss of warranty, or personal

injury.
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Under no circumstances should this action be
performed.
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Chapter 1

Introduction

The GR-3 receiver is a multi-frequency, GPS+ receiver built to be the
most advanced and compact receiver for the surveying market. The
receiver is a multi-function, multi-purpose receiver intended for
precision markets. Precision markets means markets for equipment,
subsystems, components and software for surveying, construction,
commercial mapping, civil engineering, precision agriculture and
land-based construction and agriculture machine control,
photogrammetry mapping, hydrographic and any use reasonably
related to the foregoing.

The GR-3 can receive and processes multiple signal types (including
the latest GPS L2C, GPS L5, GLONASS C/A L2, and GALILEO
signals) improving the accuracy and reliability of your survey points
and positions, especially under difficult jobsite conditions. The multi-
frequency and GPS+ features of the receiver combine to provide a
positioning system accurate for any survey. Several other features,
including multipath mitigation, provide under-canopy and low signal
strength reception. The receiver provides the functionality, accuracy,
availability, and integrity needed for fast and easy data collection.

Figure 1-1. GR-3 Receiver

P/N 7010-0736 1-1



Introduction

Principles of Operation

Surveying with the right GPS receiver can provide users accurate and
precise positioning, a requirement for any surveying project.

This section gives an overview of existing and proposed Global
Navigation Satellite Systems (GNSS) and receiver functions to help
you understand and apply basic operating principles, allowing you to
get the most out of your receiver.

GNSS Overview

Currently, the following three global navigation satellite systems
(GNSS) offer line-of-site radio navigation and positioning, velocity,
and time services on a global, all-weather scale to any user equipped
with a GNSS tracking receiver on or near the Earth’s surface:

* GPS - the Global Positioning System maintained and operated by
the United States Department of Defense. For information on the
status of this system, visit the US Naval Observatory website
(http://tycho.usno.navy.mil/) or the US Coast Guard website
(http://www.navcen.uscg.gov/).

* GLONASS - the Global Navigation Satellite System maintained
and operated by the Russian Federation Ministry of Defense. For
information on the status of this system, visit the Coordinational
Scientific Information Center website (http://www.glonass-
center.ru/frame_e.html).

* GALILEO - an upcoming global positioning system maintained
and operated by Galileo Industries, a joint venture of several
European space agencies/companies working closely with the
European Space Agency. Unlike GPS and GLONASS, this is a
civil endeavor and is currently in the development and validation
stage. For information on the status of this system, visit the
Galileo Industries website (http://www.galileo-industries.net).

1-2 GR-3 Operator's Manual



Principles of Operation

Despite numerous technical differences in the implementation of
these systems, satellite positioning systems have three essential
components:

» Space — GPS, GLONASS, and GALILEO satellites orbit
approximately 12,000 nautical miles above Earth and are
equipped with a clock and radio. These satellites broadcast
ranging signals and various digital information (ephemerides,
almanacs, time&frequency corrections, etc.).

¢ Control — Ground stations located around the Earth that monitor
the satellites and upload data, including clock corrections and
new ephemerides (satellite positions as a function of time), to
ensure the satellites transmit data properly.

e User — The community and military that use GNSS receivers to
calculate positions.

Calculating Absolute Positions

When calculating an absolute position, a stationary or moving
receiver determines its three-dimensional position with respect to the
origin of an Earth-Center Earth-Fixed coordinate system. To calculate
this position, the receiver measures the distance (called pseudo-
ranges) between it and at least four satellites. The measured pseudo-
ranges are corrected for clock differences (receiver and satellites) and
signal propagation delays due to atmospheric effects. The positions of
the satellites are computed from the ephemeris data transmitted to the
receiver in navigation messages. When using a single satellite system,
the minimum number of satellites needed to compute a position is
four. In a mixed satellite scenario (GPS, GLONASS, GALILEO), the
receiver must lock onto five or more satellites to account for the
different time scales used in these systems and to obtain an absolute
position.

P/N 7010-0736 1-3



Introduction

Calculating Differential Positions

DGPS, or Differential GPS, is a relative positioning technique where
the measurements from two or more remote receivers are combined
and processed using sophisticated algorithms to calculate the
receivers’ relative coordinates with high accuracy.

DGPS accommodates various implementation techniques that can be
classified according to the following criteria:

* The type of GNSS measurements used, either code-phase
differential measurements or carrier-phase differential
measurements

* If real-time or post-mission results required

Real-time applications can be further divided according to the
source of differential data and communication link used.

With DGPS in its most traditional approach, one receiver is placed at
a known, surveyed location and is referred to as the reference receiver
or base station. Another receiver is placed at an unknown location and
is referred to as the remote receiver or rover. The reference station
collects the code-phase and carrier-phase measurements from each
GNSS satellite in view.

* For real-time applications, these measurements and the reference
station coordinates are then built up to the industry standard
RTCM—or various proprietary standards established for
transmitting differential data—and broadcast to the remote
receiver(s) using a data communication link. The remote receiver
applies the transmitted measurement information to its observed
measurements of the same satellites.

* For post-mission applications, the simultaneous measurements
from reference and rover stations are normally recorded to the
receiver’s internal memory (not sent over communication link).
Later, the data are downloaded to computer, combined, and
processed.

Using this technique, the spatially correlated errors—such as
satellite orbital errors, ionospheric errors, and tropospheric
errors—can be significantly reduced, thus improving the position
solution accuracy.
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A number of differential positioning implementations exist, including
post-processing surveying, real-time kinematic surveying, maritime
radio beacons, geostationary satellites (as with the OmniSTAR
service), and satellite based augmentation systems (WAAS, EGNOS,
MSADS).

The real-time kinematic (RTK) method is the most precise method of
real-time surveying. RTK requires at least two receivers collecting
navigation data and communication data link between the receivers.
One of the receivers is usually at a known location (Base) and the
other is at an unknown location (Rover). The Base receiver collects
carrier phase measurements, generates RTK corrections, and sends
this data to the Rover receiver. The Rover processes this transmitted
data with its own carrier phase observations to compute its relative
position with high accuracy, achieving an RTK accuracy of up to 1 cm
horizontal and 1.5 cm vertical.

Essential Components for Quality Surveying
Achieving quality position results requires the following elements:

* Accuracy — The accuracy of a position primarily depends upon
the satellite geometry (Geometric Dilution of Precision, or
GDOP) and the measurement (ranging) errors.

— Differential positioning (DGPS and RTK) strongly mitigates
atmospheric and orbital errors, and counteracts Selective
Availability (SA) signals the US Department of Defense
transmits with GPS signals.

— The more satellites in view, the stronger the signal, the lower
the DOP number, the higher positioning accuracy.

* Availability — The availability of satellites affects the calculation
of valid positions. The more visible satellites available, the more
valid and accurate the position. Natural and man-made objects
can block, interrupt, and distort signals, lowering the number of
available satellites and adversely affecting signal reception.

P/N 7010-0736 1-5
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* Integrity — Fault tolerance allows a position to have greater
integrity, increasing accuracy. Several factors combine to provide
fault tolerance, including:

— Receiver Autonomous Integrity Monitoring (RAIM) detects
faulty GNSS satellites and removes them from the position
calculation.

— Five or more visible satellites for only GPS or only
GLONASS; six or more satellites for mixed scenarios.

— Satellite Based Augmentation Systems (WAAS, EGNOS,
etc.) creates and transmit, along with DGPS corrections, data
integrity information (for example, satellite health warnings).

— Current ephemerides and almanacs.

Conclusion

This overview simply outlines the basics of satellite positioning. For
more detailed information, visit the TPS website.

Receiver Overview

When power is turned on and the receiver self-test completes, the
receiver’s 72 channels initialize and begin tracking visible satellites.
Each of the receiver’s channels can be used to track any one of the
GPS, GLONASS, or GALILEO signals. The number of channels
available allows the receiver to track all visible global positioning
satellites at any time and location.

An internal GPS+ antenna equipped with a low noise amplifier (LNA)
and the receiver’s radio frequency (RF) device are connected with a
coaxial cable. The wide-band signal received is down-converted,
filtered, digitized, and assigned to different channels. The receiver
processor controls the process of signal tracking.

Once the signal is locked in the channel, it is demodulated and
necessary signal parameters (carrier and code phases) are measured.
Also, broadcast navigation data are retrieved from the navigation
frame.
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After the receiver locks on to four or more satellites, its absolute
position in WGS-84 and the time offset between the receiver clock
and GPS time are computed. This information and the measurement

data can be stored in the optional MMC or SD card! and downloaded
later onto a computer, then processed using a post-processing
software package. When the receiver operates in RTK mode, raw data
measurements can also be recorded into the receiver’s internal
memory. This allows the operator to double check real-time results
obtained in the field.

Depending on your options, capabilities of the receiver include:

Multipath reduction
Satellite based augmentation systems (WAAS, EGNOS, etc.)

Adjustable phase locked loop (PLL) and delay lock loop (DLL)
parameters

Dual- or multi-frequency modes, including static, kinematic, real-
time kinematic (RTK), and differential GPS (DGPS) survey
modes (DGPS modes include static, kinematic, and RTK)

Auto data logging
Setting different mask angles
Setting different survey parameters

Static or dynamic modes

1. MMC = multi-media card; SD = secure digital

P/N 7010-0736 17
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Getting Acquainted

The GR-3 is a 72-channel GPS receiver with external, detachable
batteries, two data ports, an interface for controlling and viewing data
logging, external memory card slot, an internal radio modem, a
Bluetooth® wireless technology module, and an optional
GSM/GPRS module.

Batteries

The GR-3 receiver comes equipped with two detachable,
rechargeable batteries (Figure 1-2) for powering the receiver.

Figure 1-2. GR-3 Batteries

The receiver draws power from one battery at a time before switching
to the second battery. Each detachable battery can provide up to
between 4h30m and 8h30m (approximate) of operation, depending on
the mode of the receiver.

The battery charging cradle (Figure 1-3) connects to a standard
power outlet using the power adapter cable and power cable/power
supply unit. When connected to a power outlet, the batteries will be
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Getting Acquainted

fully charged in approximately six hours. The batteries should run at
no less than 80% capacity after 500 charging cycles. These batteries
do not need to be drained before recharging.

The charger has two ports, one button, and three LEDs.

* The two ports connect the charger to either a receiver or an
external power source. The ports charge or drain the batteries
simultaneously.

» The STATUS button activates the battery LEDs.

Press STATUS to display the amount of charge for the
corresponding battery.

* The two battery LEDs display the percentage of charge in the
attached battery.
— Green: indicates greater than 85% charge.
— Orange: indicates an intermediate charge.
— Red: indicates less than 15% charge.
* The power LED lights up when the charger is connected to an
external power source; such as an electrical outlet or another

power source (12 volt battery).
Two power in/out ports

STATUS
Battery Button Battery . %’@@m -
— =
| | A=t
@ STATUS @ ~ N ~ ~
@
Power

Figure 1-3. Battery Charger with Batteries

The battery charger can also be attached to a tripod, belt, or RTK pole
to provide external power to the base station or rover.

P/N 7010-0736 1-9
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The AA battery shell (Figure 1-4) holds four AA batteries to provide
an easily portable backup power source for the receiver. Due to
variances in AA battery capacity, and the mode of the receiver and
type of modem, the amount of time the receiver is powered will vary.

——

o] O 0

O | | (©
[E—

Figure 1-4. AA Battery Shell (Open)

Do not use the AA battery shell when the radio

E Do not use rechargeable AA batteries.
modem is in transmitter mode.

GR-3 Receiver

The GR-3 receiver’s advanced design reduces the number of cable
required for operation, allowing you to survey more reliably and
efficiently. The casing allocates space for two removable,
rechargeable batteries, SD/MMC and SIM card slots, a Bluetooth
wireless technology module, a multi-system receiver board, and a
radio modem communications board.

The GR-3 comes in one of the following configurations:

e with an FH915 Plus TX/RX/RP! radio modem

¢ with an FH915 Plus TX/RX/RP radio modem and a GSM/GPRS
module

¢ without a radio modem

Other features include two data ports, a power port, and a MINTER
for viewing status and controlling data input/output.

1. RP =repeater
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MINTER

The MINTER is the receiver’s minimum interface used to display and
control data input and output (Figure 1-5).

The battery LEDs display the power status for each battery:
* Green — indicates greater than 85% charge.
* Orange — indicates an intermediate charge.

* Red — indicates less than 15% charge.

The STAT LED displays the status of tracked satellites.
» Red blink — receiver is on, but no satellites being tracked.

* Green blink — receiver is on and tracking satellites; one blink per
tracked GPS satellite.

* Orange blink — receiver is on and tracking satellites; one blink per
tracked GLONASS satellite.

REC RXTX
STAT -\ -\ /-

/-BT
0] 0]

FUNCTION

Battery

Power FUNCTION L

Button Button | |
(T =)

Figure 1-5. GR-3 MINTER
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The REC LED displays the data recording status. See “The
FUNCTION button” on page 1-13 for more information on REC
LED behavior when using the FUNCTION button.

* Green blinks — each blink indicates that data is being written to
the SD/MMC card.

* Solid Orange — indicates the receiver is changing modes.

* Orange blinks — indicates that the receiver is checking its internal
file system (after clearing the NVRAM or loading new firmware).
During this operation, the file system is not accessible for CDU
(control display unit) applications or for data recording. This
operation may require from fractions of a second to several
minutes, depending on the circumstances and the amount of
internal memory.

¢ Solid Red — indicates a fault condition with the receiver (no more
memory, no SD/MMC card inserted, a hardware problem, or an
improper OAF).
Table 1-2 on page 1-14 describes the REC LED status when using the
FUNCTION button.

The RX TX LED displays the status of the modem. Table 1-1
describes the LED colors and patterns for the different modems
available for the GR-3 receiver.

Table 1-1. RX TX LED Indications

¢ No light — modem is turned off.
¢ Green flashes — modem is in receiver mode.

¢ Solid Green — a radio link has been established; modem is
ready to receiver data.

FH915 Plus || Solid Green plus Red flashes — modem is receiver data.

Modem ¢ Solid Red — modem is in transmitter mode.

¢ Red flashes — a fault condition has been detected. Check the
condition of the radio modem’s antenna to ensure it is
undamaged, and is connected properly and securely. Also make
sure nothing interrupts the signal.

* Red flashes plus Green flashes — modem is in command mode.
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Table 1-1. RX TX LED Indications (Continued)

* Solid Orange (Red and Green) — the modem is initializing.

¢ Green flashes — the modem is on, registered on the network,
and is waiting for incoming calls (Slave mode).

GSM/GPRS ¢ Solid Red — a connection has been established.

¢ Green flashes — the modem is in direct control mode (Daisy
Chain).

* Orange flashes — an error has occurred (initialization error,
wrong PIN code, etc.).

The BT LED indicates the level of activity at the Bluetooth wireless
technology communication link:

¢ Blue flashes — the Bluetooth module is on but no connection is
established.

* Solid blue light — the Bluetooth module is on and a connection
has been established.

* No light — the Bluetooth module is off.
The power button turns the receiver on and off.

The FUNCTION button switches the receiver between information
modes and post-processing modes, starts/stops data recording, and
changes the baud rate of the serial port to 9600. See “MINTER
Operation” on page 4-7 for more information. Table 1-2 on page 1-14
describes the REC LED status when using the FUNCTION button.

P/N 7010-0736 1-13



Introduction

Table 1-2. FUNCTION Button Operations and REC LED Status

FUNCTION Key REC LED Status

When data recording is off, and the FUNCTION key is...

No light No data recording.

Orange blink | Internal file system test in progress.
Not pressed

Red No free memory; hardware problem with
data recording. No SD/MMC card.

If FUNCTION key mode is “LED blink mode switch”

Orange Release to change information mode.
Pressed for < 1
second If FUNCTION key mode is “Occupation mode switch”
Orange No function.

If FUNCTION key mode is “LED blink mode switch”

Green Release to start data recording (post-

Pressed for 1-5 processing occupation mode undefined).

seconds
If FUNCTION key mode is “Occupation mode switch”
Green Release to start recording (Kinematic or
Static post-processing occupation mode)
Pressed for 5-8 Red Release to turn serial port A baud rate to
seconds 9600 bps.
Pressed for > 8 No light No function.
seconds
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Table 1-2. FUNCTION Button Operations and REC LED Status (Continued)

FUNCTION Key

REC LED

Status

When data recording is on, and the FUNCTION key is...

Not pressed

Red

No free memory; hardware problem with
data recording.

If FUNCTION key mode is “LED blink mode switch”

Green

Data recording started (post-processing
occupation mode undefined).

If FUNCTION key mode is Occupation mode switch

Green Data recording started (Kinematic post-
processing occupation mode).
Orange Data recording started (Static post-

processing occupation mode).

Pressed for < 1
second

If FUNCTION key mode is “LED blink mode switch”

Orange

Release to change information mode.

If FUNCTION key mode is “Occupation mode switch”

seconds

Orange Release to toggle between Static and
Kinematic post-processing modes.
Pressed for 1-5 No light Release to stop data recording.
seconds
Pressed for 5-8 Red Release to turn serial port A baud rate to
seconds 9600 bps.
Pressed for > 8 No light No function (data recording still on).
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Data and Power Ports
The GR-3 has the following three ports (Figure 1-6):

* USB - rimmed in yellow; used for high-speed data transfer and
communication between the receiver and an external device.

The body of the connector on the corresponding cable is yellow.

¢ Serial — rimmed in black; used for communication between the
receiver and an external device.

The body of the connector on the corresponding cable is black.

¢ Power — rimmed in red; used to connect the receiver to an
external power source. This port can also be used to charge the
batteries.

The body of the connector on the corresponding cable is red.

uUsB Serial Power
(yell\ow) (black) (rled)

m>—mn

Figure 1-6. GR-3 Ports
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External Radio Antenna Connector

The SS antenna connects to the external antenna connector on the
GR-3 radome (Figure 1-7). The SS/GSM antenna uses a reverse
polarity TNC connection.

External
Antenna
Connector

Figure 1-7. GR-3 Radome and External Antenna Connector

Connector

The bottom connector (Figure 1-8) connects the receiver to either a
standard 5/8" thread pole/adapter or the quick disconnect (see “The
quick disconnect adapter” on page 1-21 for details).

Bottom Connector
for Standard Setups

Figure 1-8. GR-3 Quick Connector
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SD/MMC and SIM Card Slots

The SD/MMC! and SIM card slots reside under the batteries near the
base of the dome.

The SD/MMC card slot is located to the left of the MINTER inside
the battery pocket (Figure 1-9) and connects an optional SD/MMC
card to the receiver board to provide memory. Once installed, the SD/
MMC card usually remains inside the receiver. The data that resides
on the SD/MMC card can be accessed via the USB or serial port, or
Bluetooth wireless technology. A secure digital card can be purchased
at your local computer supply store.

The SIM card slot is located to the right of the MINTER inside the
battery pocket and allows a standard SIM card to be installed in the
receiver. Once installed, the SIM card provides a unique identification
for the receiver’s GSM module and enables the receiver’s GSM
functionality based on the subscribed services (the receiver board
accesses the GSM module which accesses the SIM card). The SIM
card usually remains inside the receiver. The GSM module with the
SIM card installed can be accessed via Modem-TPS for configuration
purposes. A SIM card can be purchased from your local cellular
provider.

Card Slot
(for SD/MMC card)

Figure 1-9. GR-3 Card Slot Example

1. MMC = multi-media card; SD = secure digital
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Cables

The GR-3 package includes standard communication and power
cables for configuring the receiver and providing a power source to
the receiver. Table 1-3 lists the cables included in the GR-3 package.

Table 1-3. GR-3 Package Cables

Cable Description Cable lllustration

Power cable

Connects the power supply unit to a
grounded outlet.

U.S. p/n 14-008052-01
Europe p/n 14-008054-01
Australia p/n 14-008053-01

Receiver power/charging cable
Connects the receiver and the S
power supply unit via SAE
connectors for battery charging.
Body of connector is red. >
p/n 14-008016-03 Q?

Cradle-to-receiver charging cable

Connects the receiver to the

o

charging cradle for external power. @ED
- ) )
p/n 14-008072-01 (1.5m long) DDD@EEDE:’)—-)))).)I»».
p/n 14-008072-02 (0.5 m long)
USB cable

Connects the receiver to an external
device (controller or computer) for
high-speed data transfer and
receiver configuration. Body of
connector is yellow.

p/n 14-008070-01

Serial cable

Connects the receiver to an external
device (controller or computer) for
data transfer and receiver
configuration. Body of connector is
black.

p/n 14-008005-02
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Other Accessories

Along with the following accessories, the GR-3 package includes a
128 MB SD memory card, 3-meter measuring tape, an adjustable
range pole, and a cable bag.

The Power Supply unit (p/n 22-034101-01) charges the internal
batteries when connected to a grounded outlet (Figure 1-10). This
unit converts the alternating current (AC) normally supplied from an
electrical outlet to a direct current (DC) used to charge the batteries
and/or power the receiver.

charging the batteries. Do not use as a power source

E The power supply unit should only be used for
during surveying.

The power supply unit can be connected to the charging cradle or
directly to the receiver. For details, see the power related sections in
Chapter 2.

Figure 1-10. Power Supply Unit

The modem antenna Spread Spectrum includes support for a GSM
modem (Figure 1-11 on page 1-20). The Spread Spectrum antenna is
a reverse polarity TNC RF connection (p/n 30-030012-01).

SS/GSM Antenna

Figure 1-11. Modem Antenna
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The universal tribrach and tribrach adapter (p/n 22-006008-01
and p/n 22-006009-011) are used to level the tripod and secure the
receiver or antenna to the tripod (Figure 1-12).

Figure 1-12. Universal Tribrach and Tribrach Adapter

The quick disconnect adapter (p/n 02-850905-01) connects to the
range pole for the receiver to slip into the top. Using the side clips, the
receiver can be quickly connected to/disconnected from the range

pole (Figure 1-13).

Figure 1-13. Quick Disconnect

For more details on the accessories and package options available for
the GR-3, contact your local Topcon dealer.
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Optional Accessories

Topcon offers a wide variety of accessories especially designed to
extend your job reliability and efficiency. For more details on the
optional accessories available for the GR-3, contact your local
Topcon dealer.

The precision tribrach adapter (Figure 1-14) is used to precisely
center, align, and level the tripod over a point. The horizontal spacer
(p/n 60419) inserts into the precision tribrach and allows the receiver
to sit securely on the precision tribrach.

Figure 1-14. Precision Tribrach Adapter and Horizontal Spacer

A hand-held controller (Figure 1-15) allows the GR-3 Base and
Rover systems to be configured and monitored directly in the field.
TopSURYV (field data collection software) and CE-CDU (receiver
configuration and monitoring software) can be used on Topcon
controllers to configure and manage the receiver.

FC-100 FC-2000

Figure 1-15. Hand-held Controller Examples
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The ODU-to-alligator clips cable (p/n 14-008097-01LF) connects
the charging cradle or receiver to an auxiliary battery for powering the
receiver during survey operations (Figure 1-13).

Figure 1-16. Auxiliary Power Cable — ODU-to-Alligator Clips

Option Authorization File (OAF)

Topcon Positioning Systems issues an Option Authorization File
(OAF) to enable the specific options that customers purchase. An
Option Authorization File allows customers to customize and
configure the receiver according to particular needs, thus only
purchasing those options needed.

Typically, all receivers ship with a temporary OAF that allows it to be
used for a predetermined period of time. When the receiver is
purchased, a new OAF permanently activates desired, purchased
options. Receiver options remain intact when clearing the NVRAM or
resetting the receiver.

The OAF enables the following kinds of functions. For a complete list
of available options and details, visit the TPS website or consult your
TPS dealer.

* Type of signal (standard L1; optional L2, L5 GPS, GLONASS,
GALILEO)

» External SD memory card

» Update rate standard 1Hz (optional 5, 10, or 20Hz)
e RTK at 1Hz, SHz, 10Hz, and 20Hz

* RTCM/CMR Input/Output

* Advanced multipath reduction

* Wide Area Augmentation System (WAAS)

* Receiver Autonomous Integrity Monitoring (RAIM)
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Notes:
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Chapter 2

Pre-survey
Preparation

Before beginning to survey with the GR-3 receiver, the following
software needs to be installed and configurations need to be applied:

O

O

Install receiver configuration software

See “Installing Topcon Software” on page 2-2.

Optional: install SD card and/or SIM card
See “Installing the Optional SD and SIM Cards” on page 2-7.

Charge the batteries
See “Charging the Batteries” on page 2-9.

Enable power source settings (either attached or external)

See “Power Management” on page 2-10 and “Powering the
Receiver” on page 2-14.

Configure the Bluetooth wireless technology module

See “Bluetooth Module Configuration” on page 2-22.

Collect almanacs and ephemerides (after first-time configuration
activities as described in Chapter 3)

See “Collecting Almanacs and Ephemerides” on page 2-26.

This chapter also discusses connecting batteries to the receiver,
connecting the receiver and a computer, and powering the receiver
using different sources.
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Installing Topcon Software

The Topcon GPS+ CD includes the following software programs used
for configuring and maintaining the receiver. This software is also
available on the TPS website to registered users.

 PC-CDU Lite « BTCONF
ver. 2.1.15 or newer ver. 1.2 or newer
e Modem-TPS ¢ FlLoader
ver. 2.0 or newer ver 1.0.07 or newer

If installing the program(s) from the GPS+ CD, insert the CD into the
computer’s CD-ROM drive. If downloading the program(s) from the
website, extract the program’s files into a folder on your hard drive.

The following sections describe installing this software, and other
sections throughout the manual describe using this software with the
receiver.

Installing PC-CDU

PC-CDU™ is a comprehensive Windows® software product
designed for controlling GPS+ receivers developed by Topcon
Positioning Systems. PC-CDU uses the GPS Receiver Interface
Language (GRIL) to configure various receiver settings and diagnose
receiver performance.

The PC-CDU software exists in two versions: a full-functionality
version called PC-CDU MS and a reduced-functionality version
called PC-CDU Lite. PC-CDU Lite is available for free on the Topcon
website or the GPS+ CD.

Computer requirements for PC-CDU are: Windows® 98 or newer and
an RS-232C or USB port, or Bluetooth capable. Use PC-CDU version
2.1.15 or newer to correctly configure the receiver.

Refer to the PC-CDU Reference Manual for full
details on installing and using PC-CDU.
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1. Create a PC-CDU folder on your hard drive and place the
compressed PC-CDU zip file (retrieved from either the website or
the GPS+ CD) in this folder.

2. Navigate to the PC-CDU folder and double-click the PC-CDU
zip file.

3. Extract the PCCDU.EXE and associated *.dll file to the PC-CDU
folder (Figure 2-1).

4. Create a shortcut on the computer’s desktop for quick access to
PC-CDU (Figure 2-1).

™ e EEX
File Edit View Favortes Tods  Help 'z
Qe - Q- [F | O search |2 Foers | [FH-
Address |53 C:itopeonipeedu v B
Folders Size | Type Date Modied
(@ pesktap 854 KB WinZip File 1/5§2004 4:56 PM #
% (2} My Documents 6KB Wirtusldevic...  6/1j2000 6:39 PM
= § My Computer L PCCDULERE 2,224k Application 12/23/2003 5:16 PM Izl'tn“

& Jd 3% Floppy (A
= e New Volume (C:)
# [2) Documents and Settings
% [ Program Files
1) quarantine
1 TEMP
= I3 topeon
3 pecdu
12 unzipped
(2 WINDOWS
® {4 CD Drive (D)
& Lk D Drive (E:) L/
< >

Figure 2-1. Extract Program and Create Shortcut

To uninstall PC-CDU, navigate to the location of the *.exe file. Select
the file and press Delete.

Installing Modem-TPS

Modem-TPS is a configuration program for the radio modem board
inside the receiver. Modem-TPS is available from the TPS website or
on the GPS+ CD.

Computer requirements for Modem-TPS are: Windows® 98 or newer
and an RS-232C port or Bluetooth wireless technology. Use Modem-
TPS version 2.0 or newer to correctly configure the receiver.

1. Navigate to the location of the Modem-TPS program and double-
click the Setup.exe icon.
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2. Keep the default installation location or select a new location.
Click Finish (Figure 2-2).

Modem-TPS Installation

Please enter the directory in which to instal
Modem-TRS

Installing Files...

Extracting file to C:YProgram Files\Modem-TRS it dil
CEE

Modem-TPS Directon:

C:%Program Files\Modem-TPS

Change

Finish |\, Cancel |

Figure 2-2. Select Modem-TPS Installation Location and Install

3. Click OK to complete the installation (Figure 2-3).

4. [If desired, create a shortcut on the computer’s desktop for quick
access to Modem-TPS (Figure 2-3).

Modem-TPS Installation

Modem-TPS installation successtul

AIDEM

Figure 2-3. Installation Complete and Shortcut

To uninstall Modem-TPS, use the Start menu on your computer:

Click Start » Programs » Modem-TPS » Uninstall Modem-
TPS, and click Yes at the prompt. Then click OK when the
uninstall completes.

Installing BTCONF

BTCONF is configuration program for the Bluetooth wireless
technology module inside the receiver. BTCONF is available from the
TPS website or on the GPS+ CD.

Computer requirements for BTCONF are: Windows® 98 or newer
and an RS-232C port or Bluetooth wireless technology. Use
BTCONEF version 1.2 or newer to correctly configure the receiver.
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1. Create a BTCONF folder on your hard drive and place the
compressed BTCONEF zip file (retrieved from either the website
or the GPS+ CD) in this folder.

2. Navigate to the BTCONF folder and double-click the BTCONF
zip file.

3. Extract the btconf.exe to the BTCONF folder.

Create a shortcut on the computer’s desktop for quick access to
BTCONEF (Figure 2-4).

& btconf g@g‘
Fle Edit View Favorites Toos Help o
Qe - Q- [F | O search |2 Foers | [FH-
Address |2 Crytopeon|bteonf v B
Folders X Name Size | Type Date Modified u
(@ Deskton | Slbtconf zip 273KE  WinZip File 8/17/2005 2:18 PM
() My Doruments A7 btconf exe 554KB  Application 6/20/2003 10:23 AM I?
= 4 My Computer
4 3% Floppy (a1 @Mﬂ?
) < New Volume (C:)
) Documents and Settings
153 Pragram Files
15 quarantine
1= TEMP
= [ topeon
3 bteonf
3 pecdu
15 unzipped
15 WINDOWS
b CD Drive (D) L/
< I >

Figure 2-4. Extract Program and Create Shortcut

To uninstall BTCONF, navigate to the location of the *.exe file. Select
the file and press Delete.

Each time you run BTCONF and configure the Bluetooth module,
BTCONEF saves the settings in a file (btconf.ini). BTCONF
automatically updates the file each time you make changes to the
Bluetooth module’s settings.

different purposes, keep copies of BTCONF in

\E : i To maintain unique Bluetooth module settings for
separate folders.
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Installing FLoader

FLoader is a firmware loading program for the power board, GPS
module, and modem board inside the receiver. FLoader is available
from the TPS website or on the GPS+ CD.

Computer requirements for FLoader are: Windows® 98 or newer and
an RS-232C port or Bluetooth wireless technology. Use FLoader
version 1.0.07 or newer to correctly configure the receiver.

1. Create an FLoader folder on your hard drive and place the
compressed FLoader zip file (retrieved from either the website or
the GPS+ CD) in this folder.

2. Navigate to the FLoader folder and double-click the FLoader zip
file.

3. Extract the FLoader.exe to the FLoader folder (Figure 2-5).

Create a shortcut on the computer’s desktop for quick access to
FLoader (Figure 2-5).

& floader g@gl
Fle Edit View Favorites Toos Help o
Qe - Q- [F | O search |2 Foers | [FH-
address |2 Critopeon|Floader v B
Folders Sizs Type Dats Modfied

@ veskiop 239KB  WinZip File 8/17/2005 2:17 PM
{23 My Documents 5248 Application 2/12i2002 5:49 PM IE‘ FL
= 4 My Computer

B e &) Fleeslr
e Hew Yolume (C:)
22 Documents and Settings
I3 Program Files
22 quarantine
2 TEMP
= (2 topeon
9 bteorf
() Floader
3 pecdu
22 unzipped
2 winpows v
< 3 @ >

Figure 2-5. Extract Program and Create Shortcut

To uninstall FLoader, navigate to the location of the *.exe file. Select
the file and press Delete.
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Installing the Optional SD and
SIM Cards

Behind each detachable battery is a slot for the optional SD card or
the optional SIM card. The SD card provides memory space in which
to save logged data; the SIM card provides telephony communication
for data transfer between two GSM-capable receivers. The SD card
can be purchased at your local computer store; the SIM card can be
purchased at your local cellular phone supply store. The receiver
currently supports an SD card with up to 1GB capacity.

Once installed, the card(s) generally remains installed. The card can
then be accessed via the receiver board using a data port or Bluetooth
wireless technology.

To install the SD card (Figure 2-6):
1. Ensure the receiver is turned off.

2. Remove the battery to the left of the MINTER.

3. Carefully insert the SD card, label side down, into the SD card
slot located at the top of the battery pocket.

Figure 2-6. Install SD Card

Do not remove the card if the receiver is powered
@ on. Damage to data may result from improper
removal of the card.
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Once the receiver is turned on, the receiver board will detect the SD
card and it will be ready to use as needed.

To install the SIM card (Figure 2-7):

The SIM card must support Circuit Switched Data to communicate
directly between receivers. The SIM card must have GPRS support to
communicate with a GPS Network IP address.

card installed (supporting Circuit Switched Data)
and have subscriptions to the same service provider
for proper communication.

% Both the Base and Rover receivers must have a SIM

Ensure the receiver is turned off.
Remove the battery to the right of the MINTER.
If needed, snap the SIM card into its holder.

Carefully insert the holder, label side down, into the SIM card slot
located at the top of the battery pocket.

Rl

Figure 2-7. Install SIM Card

Once the receiver is turned on, the receiver board will detect the SIM
card and it will be ready to use as needed.
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Charging the Batteries

Before beginning to work, fully charge the batteries for maximum
operating time (Figure 2-8 on page 2-10).

* If the batteries are attached to the charging cradle, an
approximately 6-hour charge cycle will fully charge the batteries;
the batteries will charge simultaneously.

* If the batteries are attached to the GR-3, an approximately 6-hour
charge cycle will fully charge the batteries; the batteries will
charge simultaneously.

The batteries can not be overcharged.

The batteries are shipped from the factory without
power. Fully charge the batteries before surveying.

Each detachable battery can provide up to between 4.5 and 8.5 hours
(approximate, at room temperature) of operation, depending on the
mode of the receiver.

the power adapter cable to the receiver’s power port
to charge the batteries. The batteries will charge
simultaneously.

i ; i If the batteries are attached to the receiver, connect

1. Remove the batteries from the receiver and insert them into the
charging cradle.

Connect the power cable to the power supply unit.

3. Connect the SAE connectors on the power adapter cable and
power supply unit.

4. Connect the power adapter cable to one of the ports on the
charging cradle (either port will charge both/either battery).

5. Plug the power supply to an available outlet. Leave for
approximately 6 hours to fully charge the batteries.
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Figure 2-8. Insert Batteries in Charger and Connect to Outlet

The Li-Ion batteries used in the battery packs should run at no less
than 80% capacity after 500 charging cycles. These batteries do not
need to be drained before recharging.

Power Management

Topcon’s PC-CDU software provides an interface for various
configuration, monitoring, and management functions for the
receiver.

For power management of the receiver, PC-CDU enables the power
source, enables the charging mode, and displays the current voltage
for the batteries.

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-19 for this procedure.

2. Once connected, click Configuration » Receiver.
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3. Select the Power Mode drop-down list to set the desired power
source (Figure 2-9). Current Mode displays the current power
source; if using the cradle, it will show “extbat.”

* Auto - receiver automatically selects the power source

* Mix — the batteries will discharge almost simultaneously

» Battery A — both batteries will discharge in sequence: first A,
then B, A, B, and so on. In this case, battery B will last 1 to 2
hours longer.

» Battery B — both batteries will discharge in sequence: first B,
then A, B, A, and so on. In this case, battery A will last 1 to 2
hours longer.

[ Receiver Configuration
| Genessl | MINTER | Posioning | Base | Rower | Pons | Events | Advarced |

(degames) oS T
Trutririd Elevwalicr: Mack: 5 Mexda e SIS el
Antenng Arberna Stonar [read o] CunertMed: [ B
' E::_I:: I___ Hu: [ __'| ey Al [~ FPower
P = Status | |
T [Eolsis dopoes| o] B Mode
getaien ol Al T = el | R )
= Cunnnt Mods g
Dowd tempesanrs . i f
hag > Cunsen g | Curent Made g
Fowet s mixber Tuan o] Battery &
2000 [ Battery B

[¥ Enabls Low Power Mode [ =]

Reiesh | |

Bt | Save | Set ol parometers 1o defauks |

Figure 2-9. Select Power Mode

4. Select the Charger Mode drop-down list to set the desired charger
mode (Figure 2-10 on page 2-12). Current Mode displays the
charging battery: a, b, ab, or none (off).

* Off — receiver will not charge batteries

* Auto — receiver automatically detects and charges both
batteries
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[ Receiver Configuration

| Genessl | MINTER | Postioning | Base | Rower | Pons | Events | ddvarced |
@ Purre sanagsiert
[deguees Pouer Charger
sl Elevalion Mask. 5 Mecds -
= Mode :
Anienng Aebanns Siot (resd ok Wbl
£ Cumeed Input* | T — .
4 Exd DE St b | = e
 uf - Slatus
= = | C Current Mode
‘rmperaiun ([Cokis dogees| '_—
Cunpnt Mode
Bowrd lompeschre R Current [Amp) : |2.DB?
Powe st modes Tuan om -
- 2|0 x|
e L
¥ Enable Low Powsr Mode [ =
Reiesh | |
Cat | Sove | ot olpoiomoters to defauks |

Figure 2-10. Select Charger Mode
5. Select the Turn on/off Slots drop-down list to set power output on
internal slots (Figure 2-11).
* On - slot C is powered if the receiver is turned on

* Off —internal slot will not be powered even if the receiver is
turned on

* Always — internal slot will be powered even if the receiver is

turned off
[ Reeniver Configuration [X]
| Genessl | MINTER | Postioning | Base | Rower | Pons | Events | ddvarced |
3 SRR Powrsl mansgement
ks Vikages [vols)
Touminsl Elevalion Mack |5 Mods =1 || Evomal: [
Anienng Ankeress Stota (e onki ARy Hooks Rt
b Cumed Inpust - | ol [ || Bt | Turn an/aff Slats
- Est. DT Slatus r—‘—-j Batlesy 8 | 2(C): |On -
Tompersiun (Colsue dogres] T .
Died s r_.. Cunpnt Mode e — 1
Cunent iArre): |
Pt ugud e Tian onoll Skils
il
| -] -
¥ Enabls Low Poswer Mode | =
Refesh | |
it | Save | Tet ol parometers to defauks |

Figure 2-11. Select Power Output Modes — Ports and Slots

6. View the Voltages information (Figure 2-12 on page 2-13).
» External — displays the external power supply’s voltage
* On Board - displays the voltage drawn by the receiver board
» Battery A — displays the voltage of battery A
 Battery B — displays the voltage of battery B
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* Charger — displays the charger’s output voltage during battery
charging

- Woltages [volts]
| Genesst | MINTER | Pesitioning | Base | Rower | Ports | Eventz | Advarced | External :
i [degaees o s OnBoard:
Tt Elavilions Mack 5 Mexds -
ot Battery & :
fntenna Aetsers Sioh road onk e b
(o Dinssipie= ;:,w [ =] Battery B
() Ext. DC Status ’—‘ﬁ
Temperalun [Colius dognes] e Charger :
Dowd tempesshare © c el |— ,—
et H
P s machers

- _]_l
[ E3

[+ Enable Low Power Mode

Reiesh | |

£t | Save | Set o parometers to detauks |

Figure 2-12. View Voltages Information

7. Select and check the Enable Low Power Mode check box to put
the receiver’s processor into low power consumption mode
(Figure 2-13).

| MINTER | Pessioning | Base | Rover | Pods | Events | Adverced |

Purret sanagemert

L [degueec) Fiower Vinlages [vols]
Tt Elavilions Mack 5 [ =1\[1| exterous. [f7
-
Antenna Aetoris Sotun s ork]— Custend Moch: On Bowd: |
~ Cumert Inpun - | Chuger e Ty AT 10
- Fd DF Status b | = e
L [ || Botewt: |
Temperatun [Colsus dogoss| e e I
Dowd tempesshare © —_—
Cueen ) |
Pt ugud e Tuan onolf Slols.
2[C]: |On -

[¥ Enable Low Power Mode r _]_'_l |

—
v Enabis Low Power Mode | J

Reiesh | |

£t | Save | Set o parometers to detauks |

Figure 2-13. Enable and Apply Power Settings
8. Click Apply.
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Powering the Receiver

When powered from the internal batteries, the receiver will constantly
switch from one battery to the other, maintaining a difference of 0.4 V
between the batteries.

To check the status of the internal batteries, view the BATT LED
or check the status using available Topcon software.
* Check the BATT LEDs for battery status.
— A green light indicates greater than 85% charge.
— An orange light indicates an intermediate charge.
— A red light indicates less than 15% charge.

* Do one of the following using PC-CDU:
— Click on Configuration » Receiver to view battery voltages
on the Receiver Configuration screen.

— Click on Help » About to view battery voltages on the About
PC-CDU screen.

Using the Detachable Batteries

The GR-3 receiver comes with two detachable, rechargeable batteries
and an AA battery shell. Each battery can provide up to between 4.5
and 8.5 (approximate) hours of operation at room temperature,
depending on the mode of the receiver and the capacity of the battery.

Table 2-1. Estimated Operating Times Using Two Fully-charged Batteries

Using the Detachable Batteries
Receiver conditions: Bluetooth = on; 10-12 SV tracked; room temperature

Modem off 17 hours
915+ modem in receive only mode 13 hours
915+ modem in 250mW transmission mode 11 hours
915+ modem in 1W transmission mode 9 hours

Using the Battery Shells and AA batteries
Receiver conditions: Bluetooth = on; 10-12 SV tracked

Modem off 2.5 hours
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To attach the batteries (Figure 2-14):

1. With the battery slightly tipped, place the bottom of the battery
into the bottom of the battery pocket.

2. Gently push the top of the battery into the battery pocket until it
snaps into place. Make sure that the clip at the top of the battery
completely snaps into place.

Figure 2-14. Insert the GR-3 Batteries
To detach the batteries:

Using the clip at the top of the battery, gently pull down and out to
detach the battery from the receiver (Figure 2-15).

Figure 2-15. Detach the GR-3 Batteries
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To assemble the AA battery shell (Figure 2-16):

4,

E Do not use rechargeable AA batteries.

Do not use the AA battery shell when the radio
modem is in transmitter mode.

Slide the back cover of the AA battery shell down and lift off.

Insert four AA batteries as shown on the inside of the shell (and
in Figure 2-16 below).

* The batteries on the left lay with the positive end towards the
bottom of the shell.

* The batteries on the right lay with the positive end towards
the top of the shell.

Replace the back cover of the shell.

Figure 2-16. Remove Cover and Insert AA Batteries

Insert the AA battery shell into the battery pocket of the receiver
as shown in “To attach the batteries” on page 2-15.
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Using an Auxiliary Power Source

In addition to the attached batteries, the receiver connects to external
batteries. External batteries allow you to continue using the receiver
in case the internal batteries become discharged.

The batteries in the charging cradle will not charge
the internal/detachable batteries.

The charging cradle is used to power the receiver.

To connect the receiver and the charging cradle (Figure 2-17):

The charging cradle with extra batteries hooks onto a tripod or belt for
a convenient power supply for the receiver. The part number for the
receiver-to-charger cradle cable is 14-008072-01 or 14-008072-02.

1. Connect one end of the cradle-to-receiver cable to the charging
cradle.

2. Connect the other end to the power port on the receiver.

To recevier and
charging cradle
using receiver-
to-charger cable

Figure 2-17. Connect the Charging Cradle and Receiver
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To connect the receiver to an auxiliary battery (Figure 2-18):

Use the ODU-to-alligator clips cable (p/n 14-008097-01LF) to
directly connect the auxiliary battery and the receiver’s power port
(without SAE).

When powering the receiver using external
@ batteries, set the charger mode to Off. Otherwise,

the detachable batteries will also charge, causing
operation time to decrease. See “Power
Management” on page 2-10 for more information
on setting the charger mode.

1. Connect the ODU-to-alligator clips cable to a 12-volt battery.

2. Connect the ODU-to-alligator clips cable to the receiver’s power
port.

3. Turn on the receiver.

- From receiver to

I\ auxiliary battery
using ODU-to-
alligator clips
cable.

Figure 2-18. Connect an Auxiliary Battery and the Receiver

A single external 12 V, 2.3 A*h battery should run the receiver and
modem for about 4.5 hours and the receiver for 6 hours.
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Turning On/Off the Receiver

To turn ON the receiver, press and hold the power button until the
LEDs briefly flash.

To turn OFF the receiver, press and hold the power key for more than
one and less than four seconds (until both the STAT and the REC
LEDs are off). This delay (about 1 second) will prevent the receiver
from being turned off by mistake.

Connecting the Receiver and a
Computer

Topcon’s PC-CDU software provides an interface for various
configuration, monitoring, and management functions for the
receiver.

To configure, manage files, or maintain the receiver, connect the
receiver and a computer using one of the following methods and start
PC-CDU:

* a Bluetooth-enabled external device (computer/controller)
* an RS232 cable and a computer/controller

* a USB cable and a computer/controller with the TPS USB driver
installed

Once you have established a connection between the receiver and the
computer/controller, you will be able to configure the receiver and its
components, send commands to the receiver, download files from the
receiver’s memory; as well as, upload new firmware using
FLoader™, upload an OAF, and upload configuration files to a
receiver.
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Establishing a Wireless Connection

The GR-3 receiver contains Bluetooth wireless technology that allows
file transfer and synchronization between the receiver and any other
external device that supports Bluetooth wireless technology; for
example, an FC-100, or a computer with USB-to-Bluetooth adapter or
PCMCA-to-Bluetooth adapter installed.

affect the Bluetooth link. The default settings for
Port D are: 115200 bps, 8 data bits, 1 stop bit, no
parity, and no handshaking.

@ Changing the receiver’s Port D default settings will

The receiver and external device connection procedure varies slightly
depending on the type of external device used. In general, the
connection procedure is as follows.

Refer to your Bluetooth-enabled external device
documentation for detailed connection information.

1. Turn on a Bluetooth-enabled external device and the receiver. The
default external device mode is Master; the receiver’s Bluetooth
module mode is Slave.

2. Instruct the external device (Master) to search for the receiver
(Slave).

3. Once the Master device detects the receiver, use the procedure
described in the external device’s documentation to connect it
with the receiver.

4. Connect to the desired configuration software (PC-CDU,
Modem-TPS, etc.) as described in the configuration sections.

If you cannot establish a connection, check that the receiver’s slot
three is enabled.

1. Connect your receiver and a computer using an RS232 cable or
USB cable and PC-CDU as seen below.

Click Configuration » Receiver » General.

3. Inthe Turn on/off Slots area, ensure the Slot 2 (C) check box is
enabled.
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Establishing an RS232 Cable

Connection

1. Using the RS232 cable, connect the serial port of your computer
(usually COM1) to the receiver’s serial port.

2. Press the power buttons on the receiver and computer to turn
them on.

3. Connect to the desired configuration software (PC-CDU,

Modem-TPS, etc.) as described in the configuration sections.

Establishing a USB Connection

Make sure the computer has the TPS USB driver installed and that the
USB option is enabled.

1.

Using the USB cable, connect the USB port of your computer to
the receiver’s USB port.

Press the power buttons on the receiver and computer to turn
them on.

Connect to the desired configuration software (PC-CDU) as
described in the configuration sections.
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Bluetooth Module
Configuration

Use BTCONEF, Topcon’s Bluetooth module’s configuration program,
and your computer to:

* access the Bluetooth wireless technology module
* configure the Bluetooth module
* check or change the module’s configuration

To access the Bluetooth wireless technology module, first download
and install BTCONEF, then connect your computer and the receiver
and run the configuration program. See “Installing BTCONF” on
page 2-4 for details.

Once you have BTCONF available, follow these steps to configure
the Bluetooth module.

1. Using the RS232 cable, connect the serial port of your computer
(usually COM1) to the receiver’s serial port. If needed, turn on
the receiver and computer.

2. Run the Bluetooth module configuration program (Figure 2-19).

For BTCONF version and copyright information, click the About
button.

BTCONF (=3

Identification l Parameters] Serial Interface]

Bluetoath Information:

About

oo
=
L |
[Shssise]

Exit

Connect

Disconnected

Figure 2-19. Bluetooth Module Configuration Main Screen
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3. From the drop-down list in the upper left corner, select the
computer serial port used for communication (Figure 2-20).

4. Click Connect to connect the computer and Bluetooth module.

BTCONE

COME = || Identification l Parameters | Serial Interface]
Bluetoath Information:
COMBE 'V About

[Bhsansss|

Exit |

Disconnected

Figure 2-20. Select Communication Port and Click Connect

Once the receiver and computer connect through BTCONF, the
Identification tab (Figure 2-21) displays the following
information:

¢ Bluetooth name — the name of the Bluetooth module.

* Bluetooth address — the unique electronic address for the
module.

¢ Firmware version — the current firmware version of the
Bluetooth module.

BTCONE

Identification | Parameters | Serial Interfacs ]

Bluetoath Information:

Abaut Bluetoath name: GR3 Rowver

Bluetooth address: 0028 BEED 0074 0003
Firmnware baze: RFCOMMI.1w16.4.4
Firmweare version: ¥1.3 pl

Lk

Disconnect

Exit

COME, 115200

Figure 2-21. BTCONF Identification Tab

The COM port and baud rate display in the lower left corner.
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5. Click the Parameters tab (Figure 2-22). The Parameters tab sets
identifying and security information for your Bluetooth module.
The security section allows you to set data security and
unauthorized access parameters for the Bluetooth module.

6. Enter up to 14 characters to set a unique name for the Bluetooth
module (Figure 2-22), and click Apply.

BTCONE

Identification

Security
Disconnect

Exit |

Serial Interface ]

o

About Bluetaath M ame: |GF|3 Fover

Blustooth PIN: |

COME, 115200

Figure 2-22. BTCONF Parameters Tab

7. To set security parameters (Figure 2-23 on page 2-25), enter and
enable the following, then click Apply:

* Bluetooth PIN — enter up to 16 characters to specify a
personal identification number for the Bluetooth module.

* Encryption — enable to have the Bluetooth module encrypt
wirelessly sent data. To read encrypted data, the user must
have the same PIN used in the device that sent the data.

* Authentication — enable to require a PIN before two
Bluetooth enabled devices (such as, the receiver and a
computer) can establish a communication link. The two
devices must use the same PIN.

<

If you do not need security settings, leave these
parameters disabled.
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BTCONE

Bluetooth Module Configuration

Identification Parameters l Serial Interface]

About Bluetaath M ame: |GF|3 Fover

Security

Disconnect

Exit |

Blustaoth PIN: [ 1234567

Authentication: v

Encryption: v

COME, 115200

Figure 2-23. BTCONF Security Parameters

8. Click the Serial Interface tab (Figure 2-24). Enable Echo to
display Bluetooth module replies and corresponding commands
on the computer terminal. If needed, click Apply.

9. Click Disconnect then Exit to quit BTCONF.

BTCONE

Identification | Parameters
About

Apply

Disconnect

e

Exit |

COME, 115200

Figure 2-24. BTCONF Serial Interface Tab
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Collecting Alimanacs and
Ephemerides

Each satellite broadcasts a navigation message that includes the
ephemeris parameters of the satellite, the almanac, and various other
information. The ephemeris parameters describe the orbital motion of
the satellite and are used to predict its location/trajectory. The
almanac gives the approximate orbit (course) for the transmitting
satellite and all other satellites in the same system only.

* GPS and GLONASS satellites broadcast ephemeris data
cyclically, with a period of 30 seconds.

* GPS satellites broadcast almanac data cyclically with a period of
12.5 minutes; GLONASS satellites broadcast almanac data
cyclically with a period of 2.5 minutes.

If the receiver has an almanac, you can considerably reduce the time
needed to search for and lock on to satellite signals.

The receiver regularly updates the almanac and ephemerides and
stores the most recent versions in its Non-Volatile Random Access
Memory (NVRAM).

1. Set up the receiver in a location with a clear view of the sky.
2. Turn on the receiver.

3. Wait for about 15 minutes while the receiver collects complete
almanac and ephemeris data from the satellites.

If 15 minutes have passed and the receiver does not
@ lock on to satellites, clear the NVRAM. See
“Clearing the NVRAM” on page 5-13 for details.

You will need to collect or update the almanac and ephemerides under
the following circumstances:

* If the receiver has been off for a long time.

* If the last known receiver position, stored in the NVRAM, is
different from the present position by several hundred kilometers.

* After loading a new OAF.
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* After loading new firmware.
* After clearing the NVRAM.

* Before surveying.
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Notes:
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Chapter 3

GR-3 Configuration

Both Base and Rover receivers must be configured according to the
desired survey method.

* In applications where real-time positioning results are required,
the Base receiver provides the correction information needed to
properly calculate the location of the Rover receiver.

A Base station is normally set up over a known point and collects
GPS/GLONASS data from satellites. As the receiver picks up
satellite data, it measures the carrier and code phases to
accurately compute and verify its location. Then, the receiver
transmits this information via radio (SS or GSM) to the Rover
receiver.

* The Rover receiver applies correction information from the Base
station to its current location to accurately calculate one or more
points.

Rovers are mobile GPS receivers on a survey pole or bipod that
compares the information from the Base station to the data it logs
from satellites and applies correction algorithms to accurately
calculate a new point.

* In applications intended for post-processing, the receivers
typically log code phase and/or carrier phase measurements
separately from common satellites and during the same time
interval. This data is then processed using post-processing
software (for example, Topcon Tools).
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When configuring receivers for RTK surveying, use the following
checklist to ensure the receivers are properly set up.

O
O

O

Perform pre-survey functions as described in Chapter 2.

Configure one receiver as an RTK Base station and the other
receiver as an RTK Rover. See “Configuring the Receiver” on
page 3-10.

Configure the communication data link for transmitting and
receiving corrections.

* For a Spread Spectrum modem, see “Configuring a Spread
Spectrum Radio Modem” on page 3-3.

* For a GSM/GPRS modem, see “Configuring a GSM Radio
Modem” on page 3-7.

Set up the Base receiver over a known point to begin collecting
static observation data and transmitting corrections. Set up the
Rover receiver to begin collecting RTK data. See “Receiver
Setup” on page 4-1 for more information.

When configuring receivers for post-processing surveying, use
the following checklist to ensure the receivers are properly set up.

O
O

O

Perform pre-survey functions as described in Chapter 2.

Configure one receiver as a Base station and the other receiver as
a Rover. See “Configuring the Receiver” on page 3-10.

Set up the Base receiver over a known point to begin collecting
static observation data. Set up the Rover receiver to begin
collecting static or kinematic observation data. See “Receiver
Setup” on page 4-1 for more information.
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Configuring the Radio Modem

Modem-TPS is Topcon’s radio modem configuration utility for
modems embedded in Topcon receivers. Modem-TPS provides the
following functions:

» Connecting a computer to an integrated radio modem via a serial
port or Bluetooth wireless technology.

* Displaying information about the radio modem installed in the
receiver.

* Programming the radio modem’s settings.

See the following sections for details on configuring the receiver with
a Spread Spectrum or GSM radio modem using Modem-TPS.

Note that the SS radio and the GSM radio do not
work simultaneously. Only one radio may be used
at a time.

When finished configuring the radio modem,
@ always disconnect from Modem-TPS before exiting
to prevent conflicts with serial port management.

Topcon’s configuration and surveying software, TopSURV or
Pocket-3D, also have the ability to configure Topcon receivers. Refer
to the TopSURYV or Pocket-3D manuals for details.

Configuring a Spread Spectrum Radio
Modem

For Topcon receivers, the integrated TPS FH915+ radio modem
provides TX/RX spread spectrum communications between a Base
and Rover. To configure a SS radio modem, have the following ready:

* Computer running Windows® 98 or newer
* Modem-TPS ver 2.0 or newer installed on the computer

* A serial cable (or Bluetooth wireless technology capabilities)
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See “Configuring a GSM Radio Modem” to configure the GSM
portion of a spread spectrum radio setup.
1. Connect the computer and receiver. Turn on the receiver.

2. Open Modem-TPS and select the COM port the receiver is
connected to (Figure 3-1). Click Connect.

File Tools Help

- o]

ECDnnenlinn

Part's setting

COomM =
Cancel

Disconnected

Figure 3-1. Connect to Modem-TPS
3. On the Radio Link tab, set the following parameters (Table 3-1)
and click Apply (Figure 3-2 on page 3-6).

Table 3-1. Receiver Parameters for the Radio Link Tab

Parameter Base Receiver Rover Receiver

Protocol Select either FH915 or FH915+ for the type of radio.

* An FH915 radio modem can be configured as a transmitter
or receiver.

* An FH915+ radio modem can be configured as a transmitter,
receiver, or repeater.

Location Select the country in which the receiver will be used.

If selecting “Australia”, the radio spectrum will be split in half
for compatibility with the available spectrum. This feature is
automatic and will be invisible to the user.

Operation Select Oft if the radio is turned off; select Repeater if the radio
mode modem includes a feature to boost the signal.
Select Transmitter. Select Receiver.
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Table 3-1. Receiver Parameters for the Radio Link Tab (Continued)

protocol, the
link rate is
selected
automatically.

Parameter Base Receiver Rover Receiver
Output power || Select the transmission power | n/a
for the radio modem.
Link rate Select the data transmission rate for the radio link.
As opposed to a baud rate (the rate of data transfer through a
serial cable interface), the link rate is the amount of data
For FHO15+ (measured in bits) the radio modem can transmit/receive over

the air in a specified time period (measured in seconds).

* 9600 — repeats data packet 3 times; packets are encoded to
decrease the affects of interference. This provides max. data
security, but reduces data throughput.

* 12000 — repeats data packets 5 times; no encoding is applied.
* 17000 — repeats data packets 3 times; no encoding applied.
* 24000 — only uses encoding.

¢ 51000 — uses no repeating or encoding. This provides max.
data throughput, but reduces data communication reliability.
For maximum efficiency, the data packet size transferred to the
radio modem in a given time should be equal to or less than the
link rate. Use Table 3-2 on page 3-5 to determine the link rate.

Channel

Assign a channel on which to transmit/receive data. Each
channel uses a unique communication frequency, allowing up to
five simultaneously transmitting radio modems, without
interference, at the jobsite.

¢ Use the same channel for both receiver in the same network.

* Assign different channels to other networks.

Table 3-2. Link Rate vs. Baud Rate Comparison

Data packet
size (in bits)

TX serial baud
rate (bps)

Link rate

RX serial baud rate (bps
(bps) (bps)

0-9600

9600; 19200 9600; 19200; 38400; 57600

9600%;12000

9600-12000

19200; 38400 19200; 38400; 57600

12000%; 24000

12000-17000

19200; 38400 19200; 38400; 57600

17000%; 24000

17000-24000

38400; 57600 24000 38400; 57600
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Table 3-2. Link Rate vs. Baud Rate Comparison (Continued)

Data packet TX serial baud Link rate .
size (in bits) rate (bps) (bps) RX serial baud rate (bps)
24000-51000 || 57600 51000 57600

a. Recommended link rate for this data packet size.
4. On the Serial Interface tab, select the following baud rate
parameters and click Apply (Figure 3-2).
* Baud Rate — select a baud rate for the modem’s serial port.
The same rate must be used for the receiver and the modem.

* RTS/CTS — controls the flow of data between the receiver and
modem. “On” enables handshaking/hardware flow control.

If the serial baud rate exceeds the link rate, enable
@ hardware handshaking to prevent the radio link

from overflowing, resulting in data loss.

ﬂ Spread Spectrum Radio Modem 915 MHz (Plus)
Flle_Tocls _Help [E Spread Spectrum Radio Modem 915 MHz (Plus)

Ble Iods telp
Radio Link |GSM | Serial interface | igentific

Radio Link | GSM  Serial Interface | Identification |
Protocal: | FHI15 Plus  ~
Apply
Location: | North America ¥
Operation mode: | Transmitter | Baud Rate: 57600 2

Output power: W hd
Link Rate: 9600 x
Channel 4 jhd

RTS/CTS o} hd

COM2, 115200 Exit

COR2, 115200

0:05:55

Figure 3-2. Apply Radio Link and Baud Rate Parameters
5. When finished, click File » Disconnect.
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Configuring a GSM Radio Modem

maintain at least 25cm between the user and the

@ To comply with RF exposure requirements,
radio modem.

For GR-3 receivers, the integrated TPS SS radio modem configured
with a GSM module provides TX/RX GSM communications between
a Base and Rover, or communication with a GPS network using IP
based connections. To configure a GSM radio modem, have the
following ready:

* Computer running Windows® 98 or newer

* Modem-TPS ver 2.0 or newer

* A serial cable (or Bluetooth wireless technology capabilities)
* The phone number of the base station

1. Connect the computer and receiver. Turn on the receiver.

2. Open Modem-TPS and select the COM port the receiver is
connected to (Figure 3-3). Click Connect.

e L IE[X]|

ﬂtunnectiun |X|

Port's setting

COM1 hd
Cancel

Disconnected

Figure 3-3. Connect to Modem-TPS

3. On the GSM tab, set the following parameters (Table 3-3 on
page 3-8) and click Apply (Figure 3-4 on page 3-8).
If some fields display “N/A”, click Refresh.
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Table 3-3. Receiver Parameters for the FCS Tab

Parameter Base Receiver Rover Receiver
Mode Select Slave. Select Master.
PIN Enter a Personal Identification Number (PIN) if required.
Dial Leave blank. Enter the phone number of the
base GSM modem.
Send time Enter a period of time in seconds in which the base/rover GSM

modem will send a service word to the rover/base GSM modem.

» This parameter is used to maintain reliable communication
between a pair of modems and avoid unnecessary modem re-
initialization.

* To ensure reliable and secure modem communication, this
parameter must be larger then the period for transmitting
differential corrections.

If the base and rover are both GR-3 receivers with internal GSM
modems, set the Send time to zero (0).

[T

4 Spread Spectrum Radio Modem 915 MHz (Plus) - Dealer
File Tools Help

Radio Link  GSM |Sema\ Interface | Identification |

Mode: Slave s Send time: |0

Dial: | Pin: [400s

hndel
| "GSMI0D","GSM1B00" "MODEL=G20"

[[ISIES]

[E Spread Spectrum Radio Modem 915 MHz (Plus) - Dealer
Eile Tools Help

Status: |Registered, home netwark

Radio Link  GSM |Ser|a| Interface | Identification |

Signal quality - [85 dB Refresh Applyn
Mode: Master - Send time: |0
COME, 115200
Dial: [p9163810998 Pin: [4008
todel

‘ "GEMI00","GSM1800","MODEL=G20"

Status: |Registered, home netwark

Signal quality : |-85 dB Refresh GSM info

COME, 115200 0:02:54

Exit

Figure 3-4. Select GSM Parameters for the Base and Rover
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4. To view GSM modem information, click GSM info (Figure 3-5).
Click Quit to return to the GSM tab.

Signal quality is a reading of the strength of the GSM signal. The
lower the number—the closer to zero—the better the signal
quality. The minimum signal (cutoff) is -111db.

[E Spread Spectrum Radio Modem 915 MHz (Plus) - Dealer glilg‘

Model
‘ "GSMI00","GSM1800","MODEL=G20"
Status:

Registerad, horme network

GPRS status: Operator
[GPRS coverage [MTS-RUS
S/M GEM modem Signal guality
[352219001334863 [83 0B
Cluit
COMB, 115200 0:04:15

Figure 3-5. View GSM Information

5. On the Serial Interface tab, select a baud rate for the modem’s
serial port. The same rate must be used for both the receiver and
the modem.

6. Click Apply, then click File » Disconnect.

7. If needed, launch PC-CDU and set up the receiver to run as an
RTK Base station.
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Configuring the Receiver

The GR-3 can be configured in several ways for collecting data for
RTK or post-processing.

¢ A static Base station collects measurement information and saves
this data to its internal memory.

¢ An RTK Base station collects measurement information,
determines differential corrections, and transmits them to the
RTK Rover(s).

* A static Rover collects observation data from the same satellites
during the same time interval as the static Base station.

* An RTK Rover collects measurement information and accepts
corrections from the RTK Base station to compute its relative
position.

* A Rover acting as a repeater to re-transmit RTK Base station
measurements to other rover receivers, extending the range of a
GPS system.

To configure, manage files, or maintain the receiver, connect the
receiver and a computer using one of the following methods, and start
PC-CDU:

* use a Bluetooth-enabled external device (computer)
e use an RS232 cable

* use a USB cable and a computer with the TPS USB driver
installed (available on the TPS website)

PC-CDU is Personal Computer-Control Display Unit software used
to manage the various functions of your receiver. The full range of
PC-CDU configuration and function is outside the scope of this
manual. For more information on any of the procedures in this section
or on PC-CDU, refer to the PC-CDU User’s Manual available on the
TPS website.

PC-CDU configures the various parts of the receiver, saving the
settings in the receiver’s memory. These settings will be reflected
when you use the MINTER. The full range of PC-CDU configuration
and function is outside the scope of this manual.
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Once you have established a connection between the receiver and the
computer, you will be able to:

* configure the receiver and its components

* send commands to the receiver

* download files from the receiver’s memory

* load a new OAF and other configuration files to a receiver

The following Base and Rover configurations are recommended for
the most common applications. However, you can select
configuration parameters as needed for your particular jobsite.

'ﬂT Do not make other changes without consulting the
EmP  PC-CDU Reference Manual.

1. Connect the receiver and computer as described in “Connecting
the Receiver and a Computer” on page 2-19.

2. Start PC-CDU on your computer. The PC-CDU main screen
displays (Figure 3-6).

Il
File Configuration Tools Ploks Help
GPS Satellites Geo %2 | Terget| GLONASS Satellites
4 | EL| az[calpi]re] tc] s5] tat sn | Fn | EL[ az[ca P ez 1] 55]
Lulghy
At
Vel
RMS5 Pos
RMS el
FOOP:
Receiver time;
Receiver date:
Clock offset:
Osc. offset:
Tracking time:
Disconnected v

Figure 3-6. PC-CDU Main Screen

Notice that the lower-left hand corner shows the receiver status as
“Disconnected”.

3. Click File » Connect.
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4. On the Connection Parameters dialog box, select the following
parameters (Table 3-4) and click Connect (Figure 3-7).

Table 3-4. Connection Parameters

Parameter RS232 or Bluetooth usB
Connection Select Direct.
Mode
Port Select the port connecting the | Select USB

computer and receiver
(typically COM1, COM2 for
RS232 and COM3, COM4,
etc. for Bluetooth)

Baud Rate Select the communication rate | n/a
between the receiver and the
computer (usually 115200).

Rec ID n/a Select the receiver’s
identification number.

RS232 or Bluetooth
x|

|’EUnnEcl|Dn mode:

Direct £ Intemet Client £ Inteinet Server |
[ Port setting: | USB
Part: [COMT 7] Bawdrate: [115200 7] T Infrared po [ Ty |
[~ RTS/CTS handshaking Eunne:hr:m mode

= " Intemet Client " Intemet Server

Pragram setting:

[~ Passivemode [ Manual mode only ~Port setting:
[ Restore the receiver's onginal baud rate on Disconnect Port IUSB ,I FecID: ISF’AZKEEMKW ~| T Infrared part
Intemnet setting:
Histnames [locahost TER port: Iﬁ
~Program setting:
Fassyord: I " Passivemode [T Manualmode only Timesut [ms]: | 500 -
™| Display dataonserver @ Logjserver evernts [~ bHE | I | Restore the receiver's arginal baud rate on Disearnest
~Internet [ Client - Server ) setting:
Connhect I Cancel |
Hast nzme [locahost TR port; [5000
Fassword: I
™| Display data onserver, W Logserver events [~ DHE leckup

Coringct I Cancel I

Figure 3-7. Connection Parameters
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Once a PC-CDU connection with the receiver has been
established, the current communications settings—such as, port
name, baud rate (if applicable), and flow control (if applicable)—
display in the lower-left corner of the main window of PC-CDU.
A timer begins to count up in the lower-right corner as well
(Figure 3-8).

-o[x]

File Configuration Taools Plots  Help

GFPS 5atellites [0) Geo |><YZ |Talget| GLOMNASS Satellites [0]
# | EL] azcal P Pel TC] 33 tat sl Fn EL] sz[cal P pre] 1] s8]

Lu g}
Alt:
Vel
RM3 Pas:
RMS Vel:
FDOP:

Receiver time: 08:06:07
Receiver date: 24.09.2002
Clack affset:

Osc. offset

Tracking time: 00:00:00

COM2, 115200 I 00:00:12

Figure 3-8. PC-CDU Connection Established

5. Click Configuration » Receiver.

change; otherwise, the receiver will not register the

% Click Apply after making any configuration
change.

6. Click Set all parameters to defaults (Figure 3-9).

o
ootk | WINTER | Postiney | Bace | Hove | Pots | Evente| Advarsed|
Elavalion sk [agennc] el Ll Valtages [veits}
Trtrnal E lervadion Mask. S Vi (ke =] || Extena ,_
E— ~Aeberen Stans (read n]— Cusrert Mode : [ | o Jrs |
" Inemal Giectipads i
1 Extanal Cager | Reey: [TE4
s B OCSu: [ Mods . [rete =] o
il - | Bamey i |72
Temperatun (Crlsas dngeres} = i
Rl ity Cunert Mode (o [
Fosver nutput modes 1 1 Tam onvolf Siots
Foits O - - Skt
- = 7 Shed
Set all parameterto defaults | Shett - on 2] | | s
[¥ Ensble Low Power Mode
Heliesh Ay
e

Figure 3-9. Set All Parameters to Defaults
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7. Click the MINTER tab and configure the following settings
(Table 3-5), then click Apply (Figure 3-10).

Table 3-5. Receiver Parameters for the MINTER Tab

Parameter Base Receiver Rover Receiver
Recording Enter 15 seconds.
interval
Elevation Enter 15 degrees.
mask angle
File name Enter a unique ID, such as the last 3 digits of receiver’s serial
prefix number.

FN key mode || (starts/stops data recording using the FUNCTION key)

For Static data recording, For RTK data recording,
select LED blink mode switch. | select Occupation mode
switch.
Initial data n/a Select Kinematic.
collection (This setting is for trajectory
dynamic surveys.)
mode
FM keymode——————
& LED blirk mode switch
Gienmal MINTER | Postonny | Hace | Hoven | Pute | Evenls | Advarsed| /
[e—— T00  {secondi N iy mode Static
Elvalinmoh fuloghe:  [5 Hegresi] = LED birk. e wwrich _" Ussupalon muads svich
File rusrm sl I Irital data collection dynamic mode:
" &l
e :
| Pl Crmstion iesde Drana reconing auto-stad RTK Rover
| 1 Log s i AFAM | ~ i On g
| Auhumat: i Helalior Mods 1 M) passetss
i el ' Oceupation mode switch
Fecording interval : 1.00 [zeconds] o
Elevation mask. fior Log file : |15 [degrees) ' Kinematic
File name prefix : log
Relish Ay I|
Ok |G | Save | Ser sl psmetess o datauti |

Figure 3-10. Configure Receiver’s MINTER for Data Recording
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8. Click the Positioning tab and set the Elevation mask to 15
(Figure 3-11), then click Apply.

£ Receiver Configueation x|

faenesal | MINTER (P0G | fave | Hoves | Puts | Evenis | Ardvared|

f?!ilm-:ﬁnn [+ Standalonn [
W oot I GPs [T G0N © GRS i indass

" DGPS [Cods Dilersis]
 RTK Fioal Al o
 RIK Faomd ¥ Rl GPS | GLonass | wass |

¢ | penfiocklusn} pin/iock|uze! pin{inck! iz pn/lock| e
;"“”""‘“m i W R Sk NF R BF W
I R N T e

I W F NFF NFF OFF

TP T tr FORFE B OARF F oEE

—_”Fm = = EAT SFF NRFF AFRF AFF
Elevation mask. I— LRl R F UFF ZF R OFF
[degree] : 15 ¥ ‘r:gr.,, IFF BRFF BFF AFF
EF F BF F MF F RF ¥
g [t =1 oo Conecon Altalock | Nenetoloch] Ao use | Mom to use|
Dt P i | . Tiopo-Conmcluon
| _ Relesh o |

Ok |G | Save | Ser sl pmetess o datauki |

Figure 3-11. Configure Receiver Positioning — Elevation Mask

9. For the Base receiver, click the Base tab and set the following
parameters (Figure 3-12 on page 3-16), then click Apply.

e GPS/GLO at one time — enable

* Antenna position — enter Lat, Lon, and Alt values using one
of the following methods:

— If known, type in the values.

— Enable Averaged and enter the Averaged Span in seconds,
then click Apply. Click Tools » Reset receiver and wait
until the specified interval (span) completes. Examine the
Base coordinates on the Base tab, they should correspond
to the coordinates obtained from the average. Click
Refresh if the coordinates are zeros.

— Click Get from receiver.

The reference geodetic coordinates specified on this
tab relate to the antenna L1 phase center.

Continue with step 11 on page 3-17 for RTK surveys or step 12
on page 3-18.

P/N 7010-0736 3-15



GR-3 Configuration

& GPS/GLO at ane fine 1

Genersh| MINTER | Pasitoning (852 || Rover | Pots | Evenis | Advanced|

Elaue St Coedingta: | Arkenna Fhase Cerie | FITCM Setngs
 BPSAELO ol om ime | Avete0ed Siaton it [0
T GPRASLO sopoumiely : -

Measuements Serk
F ALl T PAY 7 PA2

M raabm S tem Used
of Satelites: |1
GPS/GLO l Gk i ] F GPE | GLOMASE

Tleletence Geadatic Comdnater Heshn:|Good =] [ Poeudorarge sclbing
a0 o0 “fooomon [u =][wen =] [ | CMA Setings e

(P g ] Tl | Swni: [0 | & CALL © PLI P PA2
A [0 m Dot Pasameires ||| | Meson: [Trirown =] GLONASS mestsce B 2

Anlsia Phase Cerbat olliat, et Sheat 18| oo |

Emt:| 0 o 00002 Fieight 10,0052 quIIJ.l

T . Corligation of Mlacsivel Ports
et from recewerl
J Bl Sty | Felesh Fi |

GPS/GLO |

Reference Geodetic Coordinate:

Lat [0 *[o0” '[on.oooon " [w =] [wes =]
Lonfo00 *[00" ' [on.00000 " [€ =]
AIt:I+U.DDDU M Diatum Farameters |

Figure 3-12. Base Configuration

alnumuodefuxl

10. For the Rover receiver, click the Rover tab and set the following
parameters, then click Apply (Figure 3-13 on page 3-17).

* Positioning Mode — For post-processed surveys, select
Standalone; for RTK surveys, select RTK float or RTK fixed.

* RTK Parameters, RTK mode — select either Extrapolation for
RTK float (kinematic) or Delay for RTK fixed (static).

— Extrapolation is for low-latency, high frequency output
(>= 5 Hz) RTK applications. The Rover will extrapolate
the Base station’s carrier phase measurement corrections
when computing the Rover's current RTK position.

This setting (extrapolation) is recommended.

— Delay is for 1 Hz high precision RTK applications. The
Rover RTK engine will compute either a delayed RTK
position (for the epoch to which the newly received
RTCM/CMR message corresponds) or the current stand-
alone position (while waiting for new RTCM/CMR
messages coming from the base).

* RTK Parameters, Dynamics — select Static or Kinematic.
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* RTK Parameters, Ambiguity fixing level — (not applicable to
RTK Float) select either Low, Medium, or High for indicator
states of 95%, 99.5%, or 99.9%, respectively. The RTK
engine uses the ambiguity fix indicator when making
decisions whether or not to fix ambiguities. The higher the
specified confidence level, the longer the integer ambiguity
search time.

Positioning Mode

Genessl | MINTER | Fostonng | tae | Hovet | Puts i v |~ Standalone " RTK Float
(" DGPS [Code Differential) &+ RTE Fixed

Feoring Vet Enabie Scknns
© Standsone  ATE Float 7 Slandsions
© DGPS (Coda Dillwential] & ATE Fireed F 06
T — TR Fa s
5 Mlitnse ~RTE made ~Dymamics Ambigahy g level
e [ " Evtrapalstion| | Static Fj IM":i
i Y || & Hindum
4 e | || e
e G -
L I= ! 7oAl B Rl [ | o Ce
s [ 5| T um wes Soaca: [y ~]

RTKP.

Ok |G | Save | Ser sl pmetess o datauki |

RTK mode—— [ Diynamic: Ambiguity fizing level
" Extrapolation | | Static . Low

. . & Medium
& Delay &+ Kinematic " High

Figure 3-13. Rover Configuration

Continue with step 11 for RTK surveys or step 12 on page 3-18.

11. For RTK surveys, click the Ports tab and set the following port
parameters for the serial port (Table 3-6), then click Apply
(Figure 3-14 on page 3-18).

<

For post-processed surveys, keep the default values

for these parameters.

Table 3-6. Receiver Parameters for the Ports Tab

Parameter Base Receiver Rover Receiver
Input n/a (Leave the default.) Select the same differential
correction format selected for
the Base.
Output Select the type and format of Select “None”.
differential corrections.
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Table 3-6. Receiver Parameters for the Ports Tab (Continued)

Parameter Base Receiver Rover Receiver

Period (sec) Enter the interval at which the | n/a (Leave the default.)
receiver will transmit
differential corrections.

Baud rate Select a baud rate to use for transmitting differential messages
from the receiver board to the modem module

The baud rate must match the modem’s serial port speed.

RTS/CTS Select to enable handshaking.

Bl Recuives Conligu ation

Geness | MINTER | Positoning| Bate | Rover Puts |Evenis | advanced|
| Sl | Pratel | Mo | USE | Ethenet | TEF | |
P £ | X Haadiate |17 =
Dhtged [11 T Faatfs] [ = | REGACE:
g et [Lenmand > Baudmie- [11520 ¥
Durgt: [Nane =] Peiedra | I /RTS/TS
SeialC Input; | Command X Baudiale: | 30400 =
Ouget: [TMn =] Peiedi: [T  RISAIS
Seisll frpl | Command - Besalinle . [115200 = \
I ndiowesd et [ricne =] eodiy [T ™ RTS/CTS
Base [N | |
. Iput : IEommand 'l Baud rate : |334DD 'l
Serial C
Output: |CMR A Period (2] : |1.UU W RTS/CTS

Réver

Input:  |CMR il Baud rate : |334DD 'l
Output : INone 'l Period [sec]:l [~ RTS/CTS

Figure 3-14. Base and Rover Configuration for RTK Surveys — Ports

12. Click the Advanced tab and then the Multipath tab. Set the
following parameters and click Apply (Figure 3-15 on
page 3-19).

Serial C

* Code multipath reduction — enable

* Carrier multipath reduction — enable
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%

Gienmal | MIMTER | Postionng | ase | Ao | Pots | Evenls Stvarced
Bnirirdrsbererer. Mulipath Fieducson | Loy Manngemert | Extrand Fsrspaerey | Fems Dot Morsagrsserd | Dgierss |

o Conte rindigusth imhactam
o chor

v Cod

SRt | e |

Ok |G | Save | Senslpssmetse o detis |

Figure 3-15. Configure Mulitpath Parameters

13. Click OK to save the settings and close the dialog box.

Once the receiver is configured, the configuration will remain
until you change it using PC-CDU/TopSURV/Pocket-3D or
clearing the NVRAM.

For more details on the settings available for configuring the Base
and Rover receivers, refer to the PC-CDU Reference Manual.

14. Continue with other configuration activities or click File »
Disconnect, then File » Exit to quit PC-CDU. Disconnecting
before exiting ensures proper port management.

exiting to eliminate possible conflicts with the

@ Disconnect the receiver from PC-CDU before
management of the computer’s serial ports.
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MINTER Configuration

The Minimum INTERface (MINTER) consists of two keys (power
and FUNCTION) that control the receiver’s operation, four LEDs
(STAT, REC, RX/TX, and BT) that display the receiver’s operational
status, and two LEDs that display the battery status (Figure 3-16).

/-BT
ﬁ

FUNCTION

Power j \_FUNCTION [ E—
Button Button | |
(=)

Figure 3-16. MINTER

The MINTER performs the following functions. For more
information on using the MINTER, see “MINTER Operation” on
page 4-7.

Turns the receiver on or off; puts it in Sleep mode.
Turns data recording on or off (FUNCTION button).
Changes the receiver’s information mode.

Shows the number of GPS (green) and GLONASS (orange)
satellites being tracked (STAT LED).

Shows the data recording status (REC LED).

Shows each time data is recorded to internal memory (REC
LED).

Shows the status of post-processing mode (static or dynamic)
when performing a Post-Processing Kinematic survey with the
help of FN key (REC LED).
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» Shows the status (high charge, intermediate charge, or low
charge) of the battery (BATT LED).

» Shows the power status for the receiver (BATT LED).

» Shows the status of the modem and if it receives signals (TX RX
LED).

* Shows Bluetooth activity (BT LED).

Use PC-CDU to configure MINTER settings. The procedure below
describes the most common settings; refer to the PC-CDU Reference
Manual for other possible MINTER configurations.
1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-19 for this procedure.
On the PC-CDU Main window, click File » Connect.
3. On the Connection Parameters dialog box, enable RTS/CTS
handshaking (Figure 3-17).
See “Connecting the Receiver and a Computer” on page 2-19 for
details on setting other parameters.
4. Click Connect.

Connect e
Irr-‘ Direct " Intemet Client " Intemet Server |

i Fort seting:

Pore [Caob1 =] Baudrate: [115200 =] ™ Infrared port
r ¥ RTS/CTS handshaking

Pragram setting:

y i
[~ Passivemode [~ Mfinuslmode only  Timeout [ms]: | 500 =2 ‘

iginal baud rate on Disconnect

¥ RTS/CTS handshaking =

TR port: [5000

= Display data on sever [ Log server events I~ BN lookup:
Cancel
Figure 3-17. Connection Parameters — MINTER Settings

5. Click Configuration » Receiver then click the MINTER tab, set
the following parameters and click Apply (Figure 3-18). See the
following pages for descriptions of these parameters.

* Recording interval on page 3-22
 Elevation mask for log file on page 3-22
* File name prefix on page 3-22

* Always append to the file on page 3-23
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e Files Creation mode on page 3-23

* Automatic File Rotation Mode (AFRM) on page 3-23
* FN key mode on page 3-24

* [Initial data collection dynamic mode on page 3-25

* Data recording auto-start on page 3-25

[l Receiver Configuration x|

General MINTER | Posiioning| Base | Rover | Ports | Events | Advanced |

Recarding interval [100 (seconds) PN ey mode
Elevalion mask for Logfie:  [5 [dearees) [rr LED blink mode switch ¢ Decupation mode switch

File name prefis : [ Iritial data eollection dynarmic mod
Always append to the fle [F Static £ Kinematic

Files Creation made Data recarding auto-star
((-‘ Loa file © AFRM | [r-‘ off < On ' Always

Automatic File Flatation Made (AFRM) parameters———

Period (sec - [2600 Fies (total JF [0
Fhase (seck: [0 Fies [remsin] [0

I | Autonaticall remove old fils

Refiesh | appy |

Exit Save | Set all parameters to defaults |

Figure 3-18. Receiver Configuration — MINTER Tab

Recording Interval parameter This parameter specifies the logging
rate of the log file when the MINTER FUNCTION button (pressed
for 1-5 seconds) activates data logging. This setting is used for both
logging a single log file and logging receiver data in AFRM mode.
Values are 1-86400 seconds. The default value is one second.

Elevation Mask for Log File parameter This parameter specifies the
minimum elevation angle for the satellites whose data will be put in
the receiver files logged when pressing FUNCTION. The default
value is five degrees.

File Name Prefix parameter This parameter specifies the prefix
added to the names of receiver files created when pressing
FUNCTION. The prefix can be up to 20 characters long. The default
value for the Name Prefix is “log”.

Log file names have the following structure:

<prefix><month><day><sequential alphabet letter>
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The file name depends on both the file creation time (month and day)
and additional letter suffixes to avoid confusion between files created
on the same day.

Always Append to the File parameter If you want new receiver
data to be appended to an existing log file, enter the desired file name
in this parameter. The setting can be up to 20 characters long.

Files Creation Mode parameter This parameter has the following
operation modes:

* Log file — If the log file radio button has been selected, pressing
the FUNCTION button closes the current log file. If data logging
is off, pressing FUNCTION opens a new log file.

* AFRM - If AFRM radio button has been selected, pressing
FUNCTION enables this mode. If AFRM has been enabled,
pressing FUNCTION disables this mode.

Automatic File Rotation Mode (AFRM) parameters TPS receivers
are capable of automatically rotating log files. During a “file rotation”
event, the receiver closes the current file and opens a new one
according to a user-defined schedule. The Period and Phase
parameters specify this schedule. File rotation launches the moment
the receiver time module Period is equal to Phase. More precisely, a
new log file opens immediately before the scheduled epoch causing
data tagged with this epoch to be recorded to the new log file.

When opening a new log file, the receiver enables the default set of
messages output with the default output period. Both the default set of
messages and the default output period are programmable.

* Period — specifies the time duration of each log file created in
AFRM mode. Values are 60 to 86400 seconds; default value is
3600 seconds.

» Phase — specifies the “phase” (constant time shift) of creating
multiple log files in AFRM mode. Values are 0 to 86400 seconds;
default value is zero seconds.

* Files (total) — a counter that specifies how many multiple log files
must be created in AFRM until this mode automatically turns off.
This counter decrements on every file rotation until it value
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becomes zero, then file rotation automatically stops. The counter
initializes with AFRM.

Note that a log file opens immediately after turning AFRM on.
This startup file is not considered a file rotation event; the AFRM
counter will not decrement.

Values are 0 to [23!-1]; default value is 0 (zero). Zero means that
an unlimited number of log files will be created.

@ The receiver’s memory holds up to 512 files.

* Files (remain) — specifies the number of files left for the receiver
to create in AFRM. Values are 0 to [23 1—1]; default value is zero.

* Automatically remove old files — when no free memory is
available to log data, automatically removes the earliest log file. If
this parameter is enabled, your receiver will erase the file with the
earliest file creation time/date. AFRM must be enabled to use this
FIFO (First-In, First-Out) feature. The default value is off
(disabled).

FN Key Mode parameter Use these two radio buttons to program
how the receiver will react when pressing the FUNCTION key.

* LED blink mode switch — pressing FUNCTION will toggle
between the MINTER’s normal/extended information modes and
start/stop data recording of Static survey.

— FUNCTION pressed for less than 1 second: changes the
information mode (Normal or Extended Information Modes).

— FUNCTION pressed for 1 to 5 seconds: starts or stops data
recording (Static post-processing mode).

* Occupation mode switch — pressing FUNCTION (less than one
second) will insert into the corresponding log file a message
indicating that the survey type has been changed from static to
kinematic, or vice versa. If the REC LED blinks green, the
current mode is dynamic, if it blinks orange, the current mode is
static. For more details, see Table 1-2 on page 1-14 and refer to
the PC-CDU Reference Manual.
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Initial Data Collection Dynamic Mode parameter These radio
buttons specify the starting occupation type descriptor inserted at the
beginning of receiver files logged. Select Static or Kinematic to
specify that the corresponding log file will start with a static (STOP)
or kinematic (GO, Trajectory) occupation, respectively.

Data Recording Auto-start parameter These radio buttons allow
you to program your receiver’s behavior in the event of a power

failure.

Table 3-7 describes the different scenarios available and the results
after power is restored to the receiver. “Specified file” refers to the file
name entered in the Always append to file field.

Table 3-7. Data Recording Parameter Behavior

Enabled Radio Button Results

logged to file
specified.

not resume when

power is restored.

resume data
logging to the
same file when
power is restored.

Before Power
Fail
aflure Off On Always
Receiver data | Datalogging will | Receiver will Receiver will resume

data logging to the
same file when power
is restored.

Receiver data

Data logging will

A new log file will

A new log file will

logged to not resume when | open when power | open when power is
default file. power is restored. | is restored and restored and data will
data will log to log to this file.
this file.
Filespecified; | No file will open | No file will open A log file with this
receiver data with this name. with this name. name will open and
logging not Data logging will | Data logging will | datalogging will start
started. not start when not start when after power is
power is restored. | power is restored. | restored.
No file Data logging will | Data logging will A log file with a
specified; not start when not start when default name will
receiver data power is restored. | power is restored. | open and datalogging
logging off. will start after power

is restored.
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Also, if Always is enabled, the receiver will automatically start
logging data (to a newly created or an existing file) in the following

three cases:

» After turning on the receiver using the power button.

» After resetting the receiver (using PC-CDU).
* After taking the receiver out of Sleep Mode.

[d receiver Configuration

General MINTER | Positoning | Base | Fover | Pats | Events | Advanced|

x|

- 00 fseconds) FN key mode
Elcvaton ek frLogfie:  [5 (éeares) (r-‘ LD e etz (6 @yt s
e e B T T ———

e e [“‘ Slalic £ Kinemaliz

Files Creation mode Data recording auto-start
[ﬁ Log file  AFRM | [ﬁ art © On  Always

[~Automatic File Rotation Mode [4FRM) parameters

Period [sec] : | 3600 Files [totzl ] |0
PFhase [sec] |0 Files [remein] |0

I= Automaticall remoye old fies

Rehesh | appy |

Exit Save | Setal parameters to defaults
I

Figure 3-19. MINTER Tab
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Chapter 4

GR-3 Receiver Setup
and Survey

After configuring the receivers for surveying, each receiver needs to
be setup up and the receiver’s height measured and the survey can
begin. The MINTER provides quick access for logging data,
changing receiver modes, and viewing general data logging and
satellite information during a survey.

Receiver Setup

A typical GPS survey system consists of a Base station set up over a
known point and a Rover receiver set up to be a mobile data collector.
After setting up the Base and Rover receivers, the antenna height
must be measured.

Before collecting data, make sure the Base and Rover receivers
contain a current almanac and current ephemeris data (see “Collecting
Almanacs and Ephemerides” on page 2-26).

Step 1: Set up the Receivers

The Base station must be set up, logging data, and transmitting data
before setting up the Rover receiver. Receiver setup for either post-
process or RTK surveys is the same.

O set up the Base station and its components.

See “To set up the Base receiver” on page 4-2 for details.

O set up the Rover receiver.

See “To set up the Rover receiver” on page 4-3 for details.
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To set up the Base receiver (Figure 4-1):

1. [Install a tripod over a known control point.

2. Secure the universal tribrach to the tripod. Place the tribrach
adapter (either universal or precision) on the tribrach and tighten
the screws.

3. Insert the L-plug (horizontal spacer) into the precision tribrach
adapter.

4. Attach the GR-3 receiver to the tribrach adapter. Attach the
desired antenna to the modem antenna connector.

5. Carefully level the tripod and tighten the screws.

6. Attach any other accessories as needed (for example, a backup
power supply).

GR-3 Receiver

Horizontal Spacer

Tribrach Adapter (Precision)

Universal Tribrach

Figure 4-1. Install Tripod and Receiver over Control Point
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To set up the Rover receiver (Figure 4-2):

1. If needed, attach the quick disconnect to the bipod/range pole.

the antenna/receiver remains unmoving during data

@ Use a bipod during post-process surveys to ensure
logging.

2. Attach the GR-3 receiver to the quick disconnect. Make sure the
receiver locks into place.

3. Attach the desired antenna to the modem antenna connector.

GR-3 Recevier

Quick disconnect

5/8 inch screw

Figure 4-2. Connect GR-3 Receiver to Bipod
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Step 2: Measure Antenna Height

The location of the antenna relative to the point being measured is
very important for both surveys in which the elevation of the points is
important and in surveys for horizontal location only. Horizontal
surveys are often larger in area than can reliably fit on a flat plane,
therefore the antenna adjustment must be done in three dimensions
and then projected onto a two dimensional plane.

The receiver calculates the coordinates of the antenna’s phase center.
To determine the coordinates of the station marker, the user must
specify the following:

* Measured height of the antenna above the station marker
* Method of measuring the antenna height
* Model of the antenna used

Antennas have two types of measurements:

¢ Vertical — measured from the marker to the antenna reference
point (ARP) located on the bottom of the receiver at the base of
the mounting threads.

 Slant — measured from the marker to the lower edge of the
antenna slant height measure mark (SHMM) located on both end
panels of the receiver.

The point to which surveying with GPS/GLONASS measures is
called the Phase Center of the antenna. This is analogous to the point
at which a distance meter measures in a prism. A user must enter the
prism offset to compensate for this point not being at a physical
surface of the prism. For a GPS/GLONASS antenna, the offset is
entered depending on the type of measurement taken.

* For vertical, the offset is simply added to the measured vertical
height to produce a “true” vertical height.

* For slant height, the vertical height must first be calculated using
the radius of the antenna, then the offset can be added.

The offsets are different because of the difference in location between
the slant measuring point and the vertical measuring point.
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1. Measure the antenna height above the control point or marker,
either the slant height or the vertical height (Figure 4-3).

2. Record the antenna height, point name, and start time in the field
notes.

A =ARP to edge =78.3
B = ARP to corner = 95.8

....... &-.-.‘ ;.-.-.z------- RPN A
Slant Height
to Base of Vertical Height
Corner on to ARP

Gray Bumper

Station Marker - .
or When measuring the height of

Tip of RTK Pole the Rover antenna, include the
height of the Quick Disconnect.

Figure 4-3. Antenna Offset Measurements
* SHMM to ARP vertical offset = 168mm

e SHMM to ARP radius = 78.3mm to side; 95.8mm to corner
Table 4-1 gives the offset values for the receivers.

Table 4-1. Offset Values for GR-3 Receiver

ARP To L1 Phase Center ARP To L2 Phase Center

Up 228.8mm 216.3mm
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Step 3: Collect Data

See the remaining sections in this chapter for more information on
collecting data.

1.

Turn on the receiver. The STAT (status) light (LED) will blink red
at first.

Once the receiver has locked on to one or more satellites, the
STAT light will blink green for GPS satellites and orange for
GLONASS satellites. A short red blink indicates that the receiver
has not solved a position. Four or more satellites provide optimal
positioning.

Once the short red blink is gone, the receiver has a position and
surveying can begin; wait for green and orange lights before
beginning data collection. This ensures that the receiver has the
correct date and time, and is locked on to enough satellites to
ensure good quality data.

The process of locking on to satellites normally takes less than
one minute. In a new area, under heavy tree canopy, or after
resetting the receiver, it may take several minutes.

To begin collecting data, press and hold the FUNCTION key (for
more than one second and less than five seconds).

Release the FUNCTION key when the REC (recording) LED
turns green. This indicates that a file has opened and data
collection has started. The REC LED blinks each time data is
saved to the internal memory.

| Use PC-CDU to configure data logging. See
% “MINTER Configuration” on page 3-20 or refer to

the PC-CDU Reference Manual.

When finished, press and hold the FUNCTION key until the
REC LED light goes out.

To turn off the receiver, press and hold the power key until all
lights go out, then release.

4-8 GR-3 Operator's Manual



MINTER Operation

MINTER Operation

The MINTER is the receiver’s minimum interface used to display and
control data input and output (Figure 4-4).

Battery

REC RX TX

STAT BT
nuy

| W Y B |

N o @ e»a> @)

FUNCTION

Power FUNCTION [

Button Button | |
(T =)

Figure 4-4. GR-3 MINTER

The MINTER performs numerous functions, including the following:

Turns the receiver on or off.
Turns data recording on or off (FUNCTION key).
Changes the receiver’s information mode.

Shows the number of GPS (green) and GLONASS (orange)
satellites being tracked (STAT LED).

Shows the data recording status and each time data is recorded to
internal memory (REC LED).

Shows the status of post-processing mode (static or dynamic)
during a post-processed kinematic survey (REC LED).

Shows the status (high charge, intermediate charge, or low
charge) of the battery (BATT LED).

Shows the power status for the receiver (BATT LED).

Shows the status of the modem and if it receives signals (RX TX
LED).

Show Bluetooth activity (BT LED).
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See “MINTER” on page 1-11 for a full description of the MINTER.

To turn on/off the receiver, press the power button (Figure 4-5).

* When turning on, press the power button until the MINTER’s
LEDs briefly flash.

* When turning off, press the power button until the LEDs go out,
then release.

Press the power
button for about 1
second to turn the

receiver on/off.

N & @ e»a> @)

FUNCTION

Power [

Button \ |
Figure 4-5. Power Button Functions

To start/stop logging data, press the FUNCTION button for 1-5
seconds (Figure 4-6).

* During data recording, the REC LED is green. Use PC-CDU to
set the recording time interval. See “Recording Interval
parameter” on page 3-22 for details.

* The REC LED blinks green each time data is written to the SD/
MMC memory.

e If the REC LED is red, the receiver has run out of memory, has a
hardware problem, has no SD/MMC card, or contains an
improper OAF (see “Option Authorization File (OAF)” on
page 1-23 for more information).

Use PC-CDU to enable the desired FUNCTION key mode in the
receiver, either “LED blink mode switch” for static surveys or
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“Occupation mode switch” for kinematic surveys. See “FN Key
Mode parameter” on page 3-24 for details.

Each time you turn off or on data recording, either a new file opens or
data appends to a particular file. See “Always Append to the File
parameter” on page 3-23 and “Files Creation Mode parameter” on
page 3-23 for information on setting these functions.

Press the FUNCTION
button for 1-5
seconds to start/stop
data logging.

K

0] 0]

FUNCTION
Button \ |

(T = )

Figure 4-6. FUNCTION Button Functions

To toggle between post-processing modes, press the
FUNCTION button for less than 1 second when “Occupation mode
switch” has been enabled using PC-CDU.

To change the information mode of the receiver, press the
FUNCTION button for less than 1 second when “LED blink mode
switch” has been enabled using PC-CDU.

To change the baud rate of the receiver’s serial port, press the
FUNCTION button for 5-8 seconds. This is useful if the data
collector does not support the rate that the receiver port is set to.

After about five seconds, the REC LED becomes red. Release the
FUNCTION button during the next three seconds.
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Static Surveying for Base
Stations

Static surveying is the classic survey method, well suited for all kinds
of baselines (short, medium, long). At least two receiver antennas,
plumbed over survey marks, simultaneously collect raw data at each
end of a baseline during a certain period of time. These two receivers
track four or more common satellites, have a common data logging
rate (5-30 seconds), and the same elevation mask angles. The length
of the observation sessions can vary from a few minutes to several
hours. The optimal observation session length depends on the
surveyor’s experience as well as the following factors:

* The length of the baseline measured

* The number of satellites in view

* The satellite geometry (DOP)

* The antenna’s location

* The ionospheric activity level

* The types of receivers used

* The accuracy requirements

* The necessity of resolving carrier phase ambiguities

Generally, single-frequency receivers are used for baselines whose
lengths do not exceed 15 kilometers (9.32 miles). For baselines of 15
kilometers or greater, use dual-frequency receivers.

Dual-frequency receivers have two major benefits. First, dual-
frequency receivers can estimate and remove almost all ionospheric
effect from the code and carrier phase measurements, providing much
greater accuracy than single-frequency receivers over long baselines
or during ionospheric storms. Secondly, dual-frequency receivers
need far less observation time to reach the desired accuracy
requirement.

After the survey completes, data the receivers collect can be
downloaded onto a computer and processed using post-processing
software (for example, Topcon Tools).
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Kinematic (Stop & Go)
Surveying for Rover Stations

In a kinematic, stop and go survey, the stationary receiver (Base
station) is set up at a known point such as a survey monument, or an
unknown point. The receiver continually tracks satellites and logs raw
data into its memory. The Rover receiver is set up at an unknown
point and collects data in static mode for 2 to 10 minutes. When
finished, assign the Rover to kinematic status and move to the next
survey point. At this point, and each subsequent point, the receiver is
changed to static mode to collect data. So, while moving, the Rover is
in kinematic mode, and while collecting data, the Rover is in static
mode.

1. Set up the Rover at an unknown point and press power. Allow the
Rover to collect static data for two to ten minutes. The REC LED
will be orange.

Check the STAT light for satellites tracked.

3. When finished, press the FUNCTION button for less than 1
second to assign the Rover to kinematic.

| Remember, if the REC LED blinks green, the
% current mode is dynamic, if it blinks orange, the

current mode is static.

4. Move the Rover to the next location (survey point), and press the
FUNCTION button for less than a second to collect the data in
static mode for two to ten minutes.

5. Repeat steps five and six until all points have been surveyed. The
occupation time for the points depends on the same factors as for
the static survey method.

6. When finished, press the FUNCTION button for one to five
seconds to stop logging data. Turn off the Rover if needed.

This method of GPS survey allows the operator to reduce the point
occupation time, thus permitting field crews to survey many more
points compared to the other methods available.
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Real Time Kinematic
Surveying

With RTK surveying, as with kinematic surveying described above,
one receiver serves as the reference station and conducts observations
with its antenna affixed to a stationary tripod or some other device.
The other receiver functions as a rover and conducts observations
(using an antenna) affixed to a mobile pole and moved to observation
points.

Unlike post-processed kinematic surveys, RTK surveys utilize a
communications link between the Base and Rover. Using a radio
modem link, the Base receiver transmits its measurement and location
data to the Rover receiver. The Rover, based on the transmitted data
and its own observation data, immediately conducts a baseline
analysis and outputs the results. For specific settings used in RTK
surveys, see “Configuring the Radio Modem” on page 3-3 and
“Configuring the Receiver” on page 3-10.

If using PC-CDU to monitor an RTK Rover receiver, check the LQO
field on the main screen (Figure 4-7 on page 4-13) to ensure the
receiver obtains differential corrections. Usually, the receiver will
start to output the coordinates of the antenna’s phase center along
with the solution type within 10-30 seconds. However, spread
spectrum radios and GSM phones may take as long as 60 seconds to
synchronize.

The geodetic coordinates displayed on the Geo tab are always
computed in WGS84 and have four solution types.

 Standalone — where the receiver computes 3D coordinates in
autonomous mode without using differential corrections.

* Code differential — where the Rover receiver computes the current
relative coordinate in differential mode using only pseudo ranges.

* RTK float — where the Rover receiver computes the current
relative coordinates in differential mode using both pseudo ranges
and phases; however, with a float solution, the phase ambiguity is
not a fixed integer number and the “float” estimate is used
instead.
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* RTK fixed — where the Rover receiver computes current relative
coordinates, with ambiguity fixing, in differential mode.

The LQ field reflects the status of the received differential messages
and contains the following information:

* Data link quality in percentage
* Time (in seconds) elapsed since the last received message

* Total number of received correct messages (dependent on the
message type received)

* Total number of received corrupt messages (dependent on the
message type received)

If the receiver is not (for some reason) receiving differential
corrections, or if none of the ports has been configured to receive
differential corrections, the LQ field will either be empty or it will
look like this: 100%(999,0000,0000).

[dPC-CDU to GR3 ID:RBPTIZQGOGW (rover) = B3
File Configuration Tools Plots Help

GPS Satellites (9] Geo IKYZ |Target| GLOMASS S atellites [6)
w [ e| szfcalpfpe] o] 5] Lt 55 43187E1'N [ on|Fn| EL] az(cafpifpz| tof 5]
i s 62 42 a1 37 & wee el BIGTETE S To o7 e ame a0 4147 4 g
07 7~ 1B 4118 18 4 30 g prestl 02 0 18+ 33 3@ 33 41 4 55
03 B3+ M2 61 42 42 B S+ puee Sl 08 06 38 206 41 43 45 4 5
10 45+ 288 50 39 39 B 5+ AMS Vel 02114mis 1810 24~ 29 3 B/ /B 4 He
1337 122 45 34 34 B 55+ pppop 17298 19 03 23+ 60 41 43 43 4 5
19 13+ 34 44 24 24 5 55+ 200 11 12+ 112 3 ¥ 37 4 55
27 BT 142 51 44 44 E 55+ LG 100 [000,02653.0000) |
25 17+ 188 43 25 5 5 G5+
29 B 298 42 21|20 4 a0 Receiver time: 14:17:05

Receiver date: 08,08, 2008

Clock offset: -0.8633 ppm LI] 'I DDX [DDD'DSES_'DDDD]

Osc. offset: -0.8633 ppm
Tracking time: 00:06:17

COM1, 115200, HS 00:02:59

Figure 4-7. PC-CDU Main Screen

P/N 7010-0736 4-13



GR-3 Receiver Setup and Survey

Notes:
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Chapter 5

Receiver and File
Maintenance

If post-processing the data after completing a survey, the data in the
receiver’s memory will need to be downloaded to a computer.
Downloading and deleting files will also prepare the receiver’s
memory for the next survey. Occasionally, the receiver’s NVRAM
may need to be cleared to eliminate communication or tracking
problems.

As project expectations expand, the receiver’s OAF may need to be
updated to provide expanded operation and functionality. The various
boards inside the receiver (GPS, power, modem, and Bluetooth)
require firmware to properly operate and provide appropriate
functionality. As TPS releases firmware updates, loading these
updates into the receiver will ensure that the receiver operates at its
full potential.

Downloading Files to a
Computer

After completing a survey, download data files to a computer for
storage, post-processing, or backup. Also, the receiver memory holds
a finite amount of files and information, so downloading data prevents
files from being lost. PC-CDU and Topcon Link both provide a file
managers to download files from the receiver to your computer, and
to delete files from the receiver. PC-CDU Lite and Topcon Link are
both free utilities available via your Topcon Dealer or the Topcon
website (Www.topconpositioning.com).
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Receiver and File Maintenance

l Use Topcon Tools to download files from the SD
card. Refer to the Topcon Tools Reference Manual
for further details.

Downloading Files via Topcon Link

Topcon Link provides two options for downloading files from a
receiver: via Windows® Explorer or via the Topcon Link interface.

Before you can download files, you must connect your receiver and
computer (see “Connecting the Receiver and a Computer” on
page 2-19 for this procedure).

...Using Windows Explorer

1.

3.

Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-19 for this procedure.

Open Windows Explorer and click the Topcon Receiver folder.
The right panel of the window displays the automatic start of
searching for Topcon receivers connected to any of the computer
ports (COM and USB) (Figure 5-1).

When finished, all receivers connected to the computer ports
(Figure 5-1) display.

| ] Topcon Receivers

File  Edt Wew Favortes Tools  Help o

Qe - O ¥ /"=5earch

Address | &) Topcan Receivers v B

{7 Folders

Folders %8 %
&) Topcon Recsivers -~
& Topcon Total Stations

Mo receivers found
& vy Metwork Places

2l Recycle Bin Sien
B3 My Blustooth Places

v

Address | ) Topeon Receivers B>

Folders E2 & - -
[ER-A] Topcc ~ “’/ ‘/

<& HE_G search for HE_GD HIPER
% HPER connect...
2 Topeon Total Stations
& My Hetwork Places
- -

v

Figure 5-1. Searching and Finding Topcon Receivers in Windows Explorer
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4. To stop searching for receivers when the desired receiver has been
found, click Stop. Only the discovered receivers will display.

@ Topcon Receivers

File Edt View Favortes Tools Help "
. @) =
e Back v () l‘_ﬁ: - Sk | [ Folders Favorites  Tools  Help
Adhess @) Topeon Receivers v B D st [ Folders
Folders x -
4@ Topeon Digtal Levels - 9 reers vl ed <
&) Topcon Receivers %8 & Q
& Topcon Total Stations Thete ars 1 new receiverls] found pallovels A

. My Wetwark Places 5 Ssarch for HIPER
o

# Recycle Bin El connect...

My Bluetooth Places ) stations

w3 My Network Places E)
2 Recycle Bin v

<

Figure 5-2. Break Of Searching Receivers
5. To update information about the receivers connected to the
computer port, click Search for connected receivers.

6. To view information about the receiver (Figure 5-3), right-click
the desired receiver and select the Properties option.

7. To view the collected raw file, click on the desired receiver.

Properties E|
% Topcon Receivers (A=] REeelar PIEEES I
File Edit Wiew Faworites Tooks  Help L
Q- @ - (T O search |[[2 Folcs Receiver:
Address | #) Topon Recsivers v He Model: HE_GD.
Folders = a‘ @ ID: 222333BBERR
) Topcon Receivers ~
= Port: Com1
& HIPER Search for : 0
& Topon Tatal Stations connect... Transfer aptions fle...
& vy Metwork Places =
2l Rec cle Bin v

213 Cancel | ‘

Figure 5-3. Receiver Properties

8. To import the file(s) from the receiver to a folder, select the
desired file(s) and copy to the folder using drag-and-drop method
(Figure 5-4).

File Edt Wiew Faworites Tooks  Help

Qs - © - F Oseuen [ roses Danrloading fle logl Ole.ps
. Downloadsd 4095 bytes of 5227
Address |2 HIPER v .
Transter rate is 4096 bytes/sec
Folders x I B Ia B
D TLpata ~ ANEENENENNNENENENNENENEE
() Topron Link Dk ' @wlb.tus log001c.tps  logh10te.tp
-
(5 Topeon Taoks Data m;n];m o
< | (¥

Figure 5-4. Start of File Import from the TPS Receiver/Import in Progress
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...Using Topcon Link

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-19 for this procedure.

2. To start Topcon Link, click the Import from Device button on
the Toolbar.

3.  From the left panel of the Import from Device dialog box,
double-click Topcon Receivers (Figure 5-5).

kA Import from Device E‘El
Lok [AHyCopaer 7] | B ki [Canondms =] | @]t
Mabile Device [ From _Net
4@ Topcan Digital Levels & lag0101b.tps
4 10p, & logD101c.tps
& Topcon Total Stations & log0101e tps
& log0314a.tps

Figure 5-5. Import From Device Window

4. The program automatically searches for Topcon receivers
connected to the computer ports (COM and USB). When finished
all receivers connected to the computer ports (Figure 5-6) display.

kA Import from Device %A Import from Device
Lookin  [&)Tapoan Receivers  ~| 40| ] 21 Lookin &) Tapoon Rieceivers v | &= 1] 1]
Search for connected receivers
& HE_GD
= HIPER.
Searching .

Stop

|

Figure 5-6. Search for Topcon Receivers
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5. To view information about the receiver, right-click the desired
receiver and select the Properties option (Figure 5-7).

= Import from Device Properties E\
Lookin: &) Topeon Receive | | E1[ = | ]

[@gSearch for comnected receivers
<& HE_GD
-

Select Receiver:
Transfer oprions File. k . (b HE 5D
ID: 222333BBEBG
Port: COML

ok Cancel | ‘

Figure 5-7. Receiver Properties

6. In the right panel of the Import From Device window, navigate to
and select, or create, a folder to save the files (Figure 5-8).

7. To view the collected raw file, double click (or click Select in the
pop-up menu) the desired receiver. To import the file(s) from the
receiver to the computer and to save in the selected folder,
highlight the desired file(s) and click the double arrows
(Figure 5-8).

8. The import in progress displays (Figure 5-8).

%A Import from Device \E\E|
Lookin [wmrer <] &fE[e] Lookin [DRawdsts - |||
& 1.tps |#] lngznnan 13 [ Syfrom _Met
&7 lago101a.tps [#logznnat13 & log0101b. tps
B lng0225a.tps ﬁ, log0101c.tps
) bps N & logD101e tps
B log0228a.tps ﬁ, log0314a.tps
B log0304a.tps
# lag0304b. tps
|# logz0041117_51538.tps % Progress... rz|

B log20041117_S1710.tps
B log20041130_2942.tps Diownloading file log0304b.tps
< | Dowrloaded 137216 bytes of 12003568

|l

Transfer rate iz 8071 bytes/sec

Close

Cancel

Figure 5-8. Select the Raw Data File to Import and View Import Progress
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Downloading Files via PC-CDU

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-19 for this procedure.

2. Open PC-CDU. On the Connection Parameters dialog box,
enable RTS/CTS handshaking and click Connect (Figure 5-9).

[# Connection Parameters x]

Conmection mods:
’7(-' Direct " Intemnet Client € Intemet Server ‘

Pott setting

Pait: |COM1 - Baud rate: | 115200 ~| ™ Infiared port

¥ RTS/CTS handshaking
I

Program selting [
ﬂ- Passive mode [~ fflanusl mods only  Timeout[ms}; [500 =

original baud rats on Disconnect

¥ RTS/CTS handshaking feus
TCR part [B000 |

Passward: |

I~ | Displey data orserver, || Log server events [~ BNS laokup
Carce
Figure 5-9. Connection Parameters — RTS/CTS Handshaking

3. Click File » File Manager, then click the Download path tab on
the File Manager dialog box (Figure 5-10).

o
Dovirload files | Current log file | Downlo% pathl
Total memory: 47348784 bytes Free memony: 47164824 bytes
Name | Size: | Date | Time
log923a 7A196  23.09.2002 84552
log523b FE7I5 23092002 &51:53
log0924a BEET  24.09.2002 F62:51
log0324b 4701 24.09.2002 35253
log0924e 45933 24.09.2002 35344
log0924d 5190 24.09.2002 35355
log524e 4676 24.09.2002 354:06
log0924f 4162 24.09.2002 35416

Save to: EATESTINGADATA

‘ I™ Exclusive mode
Uszing: IEurrent port [COMZ] j Block. size: |51 2 bytes j
Downloadl Delete | Refresh I Exit |

[

Figure 5-10. Find Files to Download

4. Navigate to or create (using the Create button) the folder in
which to download and store files.

5. Click the Download files tab and select the file(s) to download
(Figure 5-11 on page 5-7).
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To select multiple files, press the shift key while clicking non-
sequential files; or, press the Ctrl key and click individual files.

M

Download files | Current lng fi\el Dowrload pathl

Total memony: 47348784 bytes Free memony: 47164824 bytes

4 2
log0324c 4333 24.09.2002 56344

Ic
loal924f 4162 24.09.2002

Save to: EATESTINGADATA

| I~ Exclusive mode
Using: m Black size:lm
ann\oadl Delete | Refresh I Exit |

[

Figure 5-11. Download Files

6. Click the Download button. During the download, status
indicators display next to each file (Figure 5-12).
* Blue indicator — file in queue for downloading.
* Red indicator — file currently downloading.
* Green indicator — file has successfully downloaded.

x
Deownload files | Current log h\el Download Dathl

Total memory: 47348784 bytes Free memony: 47164824 bytes
Size | Date | Time
® |og0923a 7E196  23.09.2002 24552
© |og0923k TEFY5  23.09.2002 2:51:53
® |og032da BEE1  24.09.2002 35251
© |og0924b 4701 24.09.2002 35253
lng0924c 4933 24.09.2002 G634
lng924d 5180 24.09.2002 F5355
lnal92de 4E76  24.09.2002 354:08
log324f 4162 24.09.2002 35416

Save to: EATESTIMNGADATA

| Blocks: 28 I” Esclusive mode
Using: | Current port [COR 2] 'l Block size: |512 bytes o
Stop I [elete | Fefresh I Exit |

19% | Downloading lng0923a. .

Figure 5-12. Download Files — Status Indicators

7. When done, click Exit on the File Manager dialog box.

8. Continue with other operations. Or, click File » Disconnect, then
File » Exit to quit PC-CDU.
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Deleting Files from the
Receiver’s SD Card

Use the following steps to delete files from your receiver.
1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-19 for this procedure.

2. On the Connection Parameters dialog box, enable RTS/CTS
handshaking (Figure 5-13).

[# Connection Parameters x]
Conmection mods:
’7(-' Direct € Intemet Client € Intemet Server ‘

Pott setting

Pait: |COM1 - Baud rate: | 115200 ~| ™ Infiared port

I
¥ RTS/CTS handshaking
I

F i

Program setting
[~ Passivemode [~ fManualmode only  Timeout [ms) |500 =

oiiginal baud rats on Disconnect

[ RTS/CTS handzhaking fem
: TCR part [B000 |

Passward: |

I= Display datzonserver | Logseivereverts [ DS lackup

Cancel
Figure 5-13. Connection Parameters — RTS/CTS Handshaking

3. Click File » File Manager and select the file(s) to delete on the
Download files tab (Figure 5-14 on page 5-9).

To select multiple files, hold down the shift key and click on non-
sequential files to select several files at once; or hold down the
Ctrl key and click on individual files.

Click Delete (Figure 5-14 on page 5-9).

5. Click Yes at the delete files confirmation dialog box. PC-CDU
deletes the selected files.

6. Click Exit on the File Manager screen.

7. Continue with other operations. Or Click File » Disconnect, then
File » Exit to quit PC-CDU.
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M

Download files | Current lng fi\el Dowrload pathl
Free memony: 47164824 bytes

Total memony: 47348784 bytes

Iog! .09,

lng1324 4533 24.09.2002
) :

logl3z4f 4162 24.09.2002

Save to: EATESTINGADATA

| I~ Exclusive mode
Using: m Block size: Im
ann\oadl Dale,lew Refresh I Exit |

[

Figure 5-14. Delete Files

Managing Receiver Memory

When using the receiver in static or dynamic applications, you may
need to know the amount of memory the receiver’s log file occupies.
The specific memory size depends on the type of data being recorded.
Use the formulas below to compute the approximate size of the
receiver’s log files. These equations are based on the default set of
messages.

* SS — the estimated size of one epoch of raw data in the receiver’s
log file (expressed in bytes).

* N - the number of observed satellites per epoch.

When recording only L1 data:
SS =183 + 22*N

When recording L1 and L2 data:
SS =230 + 44*N
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Managing Receiver Options

The Option Authorization File enables certain functions, features, and
options in the receiver, such as the following:

* the type of signal (L1, L1/L2, etc.) the receiver will process
* the amount of data the receiver will store in the memory
* the rate at which data will be transmitted or received

For a complete list of available options and details, consult with your
TPS dealer.

Checking the Receiver’s OAF

Use PC-CDU to view the status of the receiver’s options.
1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-19 for this procedure.

2. Click Tools » Receiver Options. The Options Manager dialog
box (Figure 5-15 on page 5-11) contains the following
information:

* Option name — a name/description of the option
* Current — the current status of the option

* Purchased — if the option is purchased or not

» Leased — if the option is leased or not

» Expiration date — the date the option will be disabled, if
applicable

Since Options can be both purchased and leased, the “Current”
status of the option displays the currently effective value. Option
values can be one of the following:

* -1 or “-----” — the firmware version does not support this
option

* 0 — the receiver option is disabled

* positive integer — the option is enabled

* yes or no — the option is either enabled or disabled
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Managing Receiver Options

3. When finished, click Exit on the Option Manager dialog box,
then click File » Disconnect to disconnect from PC-CDU (and
prevent conflicts with serial port management).

ﬁ, Option Manager - IEI Iil

Option name Current | Purchased |  Leased | Exp. date ||
Toals GPS yes yes no
L GLOMASS yes yes no
Initialize file system ] Ves Ves o
Clear NVRAM (] ves ves ho
Reset receiver Cinderella yes yes no
Position update rate [Hz] 20 20 1]
options Fiaw data update rate [Hz] 20 20 0
Code differential Baze yes yes no
Code differential Rover yes yes no
RTK Base yes yes no
RTK Rover [Hz] 20 20 1]
Memory [Mb] 7B 7B 1]
Co-0p Tracking yes yes no
1-PPS Timing Signal 2 2 1]
Ewvent Markers 2 2 1]
In-Band Int. Rejection 1 1 1]
Multipath Reduction yes yes no
Frequency [nput yes yes no
Freq. Lock and Output yes yes no
Serial Port A [Kbps] 460 460 1]
Serial Port B [Kbpsg] 460 460 1]
Serial Port C [Kbps] 460 460 1]
Serial Port D [Kbps] 460 460 1]
Infrared Part ho ho ho
Parallel Port e ho ho
Sp.Sp. Freq. Hop. no no no
Sp.Sp. Direct no no no
Falk yes yes no
[ratumsz support yes yes no
Magnetic azimuth yes yes no

Geoid height yes yes no —
‘Way Point Mavigation e yes no

WAKS yes yes yes 8/1/2001

OMMISTAR s yes no
RTCH Output 3 2 1]
RTCH Input 2 2 1]
ChA Dutput 1 1 1]
CA Input 1 2 1]
JPS Output 1 1] 1]

JPS Input 2 0 0 LI

Fiefrezh | Load | Stop | Exit |
| y

Figure 5-15. View Option Manager
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Loading an OAF

Topcon Positioning System dealers provide customers with OAF
files. For any OAF related questions, e-mail TPS at

options @topconps.com and include the receiver’s ID number (see the
bottom of the receiver for the ID).

1.

To load a new OAF, follow steps one and two in “Checking the
Receiver’s OAF” on page 5-10.

Click Load at the bottom of the Option Manager dialog box (see
Figure 5-15 on page 5-11).

Navigate to the location of the new Option Authorization File.

OAFs have .jpo or .tpo extensions and are unique to each receiver
(Figure 5-16).

Select options file @g|
Look ire | e Local Disk [C:) x| e ®m ek E-
[ WINDOWS uoaf_6_3_turbo.tpo

SPGLOMNZDNVEK.tpo
BPNSYXOWUTC tpo
BQCSHPQYIGW-1.tpo
BOCSHPQYIGW bpo
PEYABDIIERK, tpo

|

<

Fiename:  [PaYAADAJGRK tpo
Files of type: |Dpti0ns files [ *tpo; “jpo ] j Cancel

Figure 5-16. Load OAF

Select the appropriate file and click Open (Figure 5-16). The new
receiver option loads onto the receiver and the Option Manager
table updates.

When finished, click Exit on the Option Manager dialog box,
then click File » Disconnect to prevent conflicts with serial port
management.

5-12 GR-3 Operator’'s Manual



Clearing the NVRAM

Clearing the NVRAM

The receiver’s Non-Volatile Random Access Memory (NVRAM)
holds data required for satellite tracking, such as ephemeris data and
receiver position. The NVRAM also keeps the current receiver’s
settings, such as active antenna input, elevation masks and recording
interval, and information about the receiver’s internal file system.

Even though clearing the NVRAM is not a common (nor normally a
recommended) operation, there are times when clearing the NVRAM
can eliminate communication or tracking problems. Clearing the
NVRAM in your receiver can be interpreted as a “soft boot” in your
computer.

After clearing the NVRAM, your receiver will require some time to
collect new ephemerides and almanacs (around 15 minutes).

Clearing the NVRAM of your receiver will not delete any files
already recorded in your receiver’s memory. However, it will reset
your receiver to factory default values.

In addition, the NVRAM keeps information about the receiver file
system. Note that after clearing the NVRAM, the receiver's STAT
LED will flash orange for a few seconds indicating that the receiver is
scanning and checking the file system.

Using the MINTER to Clear the
NVRAM

1. Press the power key to turn off the receiver.
Press and hold the FUNCTION key.

3. Press and hold the power key for about one second. Release the
power key while continuing to hold the FUNCTION key.

. Wait until the STAT and REC LEDs are green
5. Wait until the STAT and REC LEDs blink orange.

6. Release the FUNCTION key while the STAT and REC LEDs
blink orange.
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Using PC-CDU to Clear the NVRAM

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-19 for this procedure.

2. Click Tools » Clear NVRAM (Figure 5-17).

Initialize file system

Reset receiver [ g

Receiver options

Figure 5-17. Clear NVRAM with PC-CDU

While the NVRAM clears, the REC LED flashes green and red; the
STAT LED flashes red. The receiver automatically disconnects when
finished.

Changing Receiver Modes

The receiver has the following three modes, two information modes
and one power modes:

* Normal Mode — the standard surveying mode.

» Extended Information Mode — used for testing purposes during
normal operation.

* Sleep Mode — used to stop recording data, but keeps the receiver
powered on “standby”.

Entering Extended Information Mode

Extended Information Mode (EIM) is used for receiver testing
purposes. In this mode, the receiver continues to work as usual, but
the STAT LED indicates “extended” information using a delimiter.

The Delimiter is a distinguishable double-blink that shows the overall
status of tests performed in EIM. The STAT LED color for delimiter
is calculated from the colors of other LED blinks, and will be one of
the following colors when the tests complete:

* Orange — at least one blink is orange.

* Red — no orange blink and at least one red blink.
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¢ Green — all other cases.

The delimiter double-blink is followed by six LED blinks
corresponding to six receiver tests, where each blink indicates the
following information:

Blink 1. Sufficient data for position computation.
Blink 2. GPS S/N ratios are good (Table 5-1).
Blink 3. GLONASS S/N ratios are good (Table 5-1).

Blink 4. Oscillator’s frequency offset is less than three ppm (parts
per million).

Blink 5. Oscillator's Allan Variance is better than 2.7e-10
(currently, always orange).

Blink 6. Continuous tracking time is more than 15 minutes.

Table 5-1. Signal-to-Noise (S/N) “Good” Ratios

CA/L1

P/L1

P/L2

GPS

51

39

39

GLONASS

51

49

40

The color of the blink indicates that information for test is unavailable
(orange), the receiver passed the test (green), or the receiver failed the
test (red).

1.

P/N 7010-0736

To switch to EIM, press and quickly release (within one second)
the FUNCTION key on the MINTER.

Watch for the delimiter double-blink. With good receiver,
antenna, and observation conditions, all blinks should be green
within 15 minutes of powering on.

* Green — ok
* Orange — wait
* Red — some tests failed
To switch back to normal mode, press the FUNCTION key.
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Sleep (Off) Mode

In sleep mode, the power board and Bluetooth module will continue
to draw power from the batteries, causing the batteries to drain over
time. Sleep mode is the normal “off” state of the receiver.

1. Turn on your receiver.

2. Press the receiver’s power key for more than four seconds and
less than eight seconds. The STAT LED will be orange. The
receiver enters Sleep Mode.

3. Any activity on the RS232 port will turn the receiver on.

If you press the power key for more than 14
@ seconds, it will be ignored. This protects receiver

operation against stuck keys.

Loading New Firmware

Base and Rover receivers must be loaded with the same firmware
version. Use the latest firmware version, available for download from
the TPS website, to ensure your receiver has the most recent updates.

The GR-3 receiver must be loaded with firmware
version 3.0 or newer.

@ Do not attempt to load firmware older than 3.0.

The receiver board and power board must be loaded with firmware
from the same package. The Bluetooth module’s firmware is
independent of the receiver card and power board, and has a different
firmware package.
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Loading New Firmware

The receiver uses FLoader, a Windows®-based utility, to load
firmware onto the receiver and power boards. You can download
FLoader to your computer from the TPS website. For more
information, refer to the FLoader User’s Manual, also available on
the TPS website. See “Installing FLLoader” on page 2-6 for installing
FLoader on the computer.

1. Download the new firmware package to your computer.

2. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-19 for this procedure.

3. Start FLoader.
On the Connection tab, select the COM port on your computer

that connects with your receiver and select its speed (usually
115200) (Figure 5-18 on page 5-17).

5. See “Loading Receiver and Power Board Firmware” on
page 5-18to load the appropriate firmware.

TPS Firmware Loader: Device = Receiver i =l

File Options Help

Cannection | Device | Program |

Connection Type: Serial Cable

Connection Setting:

PLC Part: IEDM‘I 'l ‘wiord Length: IS 'l
Baud rate: |1152DD 'l Parity: INone 'l
Handzhaking: INone 'l Stop Bits: I‘I 'l

|25 il 200z [16:08.11

Figure 5-18. FLoader Main Screen
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Loading Receiver and Power Board
Firmware

Receiver and power board firmware is released as a compressed file
that you download and decompress. This file contains the following
three files:

* ramimage.ldr — the Receiver board RAM file
» main.ldp — the Receiver board Flash file
» powbrd.ldr — the Power board RAM file

firmware. These files must come from the same

@ You must load all three files when loading new
firmware package.

1. In FLoader, click the Device tab and set the Device Type as
“Receiver”. Then click Get from Device for device information
(Figure 5-19).

ETFS Firmware Loader: Device = Heceiver

File Options Help

Connection  Device IProgramI

Device Type: Receiver 'I

Device Information

Model:

1D:

Firmware
Hardware:
FiAb Size, KB:

Gt from evics Savelofie | Cancel |

|31 Mar 2003 [17:53.44

Figure 5-19. Set Device Type
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2. Click the Program tab and set the Capture Method to “Soft
Break Capture” (recommended) (Figure 5-20).

TPS Firmware Loader: Device = Receiver
File Options  Help
Eonnecllon} Device Frogram ]
Capture tethod: | Soft Break Capture -
Firrmweare
@ RAM file: |C:\FLoader_Firmware\GR3_3_D'iamimage. ldr | EBrowseR
@ Flash fle: | C:\FLoader_FirmwarshGRI_3_Thmain dp x| BrowseF
LCancel ‘
Feady 03 Jun 2006 |15:57.38

Figure 5-20. Program Tab Settings

3. Browse for and select the receiver board’s RAM file and Flash
file (Figure 5-20).
4. Click Load and wait until 100% of the files load into the receiver.

displays at the bottom of the dialog box. Select the

@ If you selected an incorrect file, an error message
correct file.

5. Click the Device tab and set the Device Type as “Receiver’s
Power Board”. Then click Get from Device for device
information (Figure 5-21).

TFS Firmware Loader: Device = Receiver's Power Board == T

File Options Help

Connection  Device IProgramI
Device Type: Receiver's Power Board 'I
Device Information
Firrmware
Hardware:
Gel fon Devics Savelafie | Cancel |
[Ready |31 Mar 2003 [17:55.40

Figure 5-21. Set Device Type
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6.

10.

Click the Program tab and set the Capture Method to “Soft
Break Capture” (recommended) (Figure 5-22).

TPS Firmware Loader: Device = Receiver's Power Board Q\E\E|
File Options Help

Ennneclinn} Device Frogram ]

Capture Method: | Soft Break Capturs -

Firmwvare

@ RAM file: |C:\FLoader_FirmwarenGR3_3_04powbrd.dr j Browse B

N N Cancel ‘

08 Jun 2006 |15:53.51

Figure 5-22. Program Tab Settings

Browse for and select the Power board’s RAM file (Figure 5-22).

Click Load and wait until 100% of the power board file loads into
the receiver.

displays at the bottom of the dialog box. Select the

@ If you selected an incorrect file, an error message
correct file.

Click File » Exit.

Clear the receiver’s NVRAM (see “Clearing the NVRAM” on
page 5-13) and update the almanac (see “Collecting Almanacs
and Ephemerides” on page 2-26) after loading new firmware.
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Chapter 6

Troubleshooting

This chapter will help you diagnose and solve some common
problems you may encounter with your receiver.

_{ﬂ- Do not attempt to repair equipment yourself. Doing
N so will void your warranty and may damage the
[WARNING hardWare.

Check This First!

Before contacting Topcon support, check the following:

* Check all external receiver connections carefully to ensure
correct and secure connections. Double check for worn or
defective cables.

* Check all power sources for drained batteries or incorrectly
connected batteries/cables.

* Check that the most current software is downloaded onto the
computer and that the most current firmware is loaded into the
receiver. Check the TPS website for the latest updates.

* If connecting via Bluetooth, check that the port used for
connection is in Command mode. See page 6-9 for details.
Then, try the following:
* Reset the receiver using PC-CDU (Tools » Reset receiver).
 Restore default settings using PC-CDU (Configuration »
Receiver, then click Set all parameters to defaults).
Clear the NVRAM (see “Clearing the NVRAM” on page 5-13).

* Initialize the file system (click Tools » Initialize file system).
This will erase all files inside the receiver.

If the problem persists, see the following sections for other solutions.
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Troubleshooting Quick List

For receiver power issues:
If “The receiver does not power up.” see page 6-3.
If “The receiver cannot establish a connection to a computer or
external controller.” see page 6-4.

For receiver issues:
If “The receiver does not lock on to satellites for a long period of
time.” see page 6-4.
If “The receiver tracks too few satellites.” see page 6-5.

If “The receiver cannot obtain Code Differential and/or RTK
solutions.” see page 6-5.

If “The receiver does not start data logging.” see page 6-8.

For Bluetooth connection issues:
If “BTCONEF error message: Can’t find receiver.” see page 6-9.
If “BTCONTF error message: Can’t find Bluetooth.” see
page 6-10.
If “BTCONF error message: Open COM# port failed: Access is
denied.” see page 6-11.
If “After searching for available devices, none are discovered.”
see page 6-11.
If “Can see the icon for the receiver’s Bluetooth module on the
computer screen, but cannot connect to it.” see page 6-11.

For modem issues:
If “Modem-TPS cannot connect to the receiver.” see page 6-12.

If “TX RX LED Blink Pattern on Error Conditions” see
page 6-13.
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Powering Problems

All receivers are preset in the factory to “Auto mode” for both
batteries. To check these settings, use the following procedure:

1. Connect your receiver and computer and run PC-CDU (see
“Connecting the Receiver and a Computer” on page 2-19).
Once connected, click Configuration » Receiver.

3. On the General tab, view the Power and Charger fields. These
fields should be set to “Auto”. If not, change them to Auto and
click Apply.

l Clearing the NVRAM will also return the receiver
% to Auto power mode (see “Clearing the NVRAM”

on page 5-13).

The receiver does not power up.

= The attachable batteries may be improperly attached.
* Check that the batteries are correctly attached.
* Check that the battery contacts at the top of the attachable
battery are clean and dust free.
= The batteries may be discharged.

* Connect/attach a fully charged battery and retry. See
“Powering the Receiver” on page 2-14.

* Charge the batteries overnight. See “Powering the Receiver”
on page 2-14.
= If using an external power source, the cable may be
disconnected or damaged.
Check that the cable is securely connected and undamaged.

= The receiver may have a defective charger or defective
batteries.
If, after changing the batteries or connecting an external

power source, the receiver still does not power up, contact
TPS Customer Support for advice.
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Receiver Problems

The following are some of the most commonly encountered receiver
problems.

The receiver cannot establish a connection to a computer or
external controller.

Cable specific problems:

= The cable is not properly plugged in.

¢ Check that the cable connector is attached to the correct
receiver port.

* Unplug the cable, then securely and properly reconnect it to
the receiver.

* See “GR-3 Receiver” on page 1-10 and “Connector
Specifications” on page A-11 for information on the
receiver’s connectors.

= The cable is damaged.

Use an undamaged cable. Contact your Dealer to replace the
cable.

Generic problems:
> The receiver port used for connection is not in Command mode.

1. Connect your receiver and a computer using a free port
(see “Connecting the Receiver and a Computer” on
page 2-19) and start PC-CDU.

Click Configuration » Receiver » Ports.
3. Change the Input for the port used for connection to
“Command”.

The receiver does not lock on to satellites for a long period of
time.

= The receiver stores an old almanac.

Update the almanac. See “Collecting Almanacs and
Ephemerides” on page 2-26 for details.
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= The corresponding receiver options may be disabled or expired
(L1/L2, GPS/GLONASS must be on to track satellites).

* See “Managing Receiver Options” on page 5-10 for details
on how to check current options.

* Order a new OAF with the desired options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the TPS website for
details

* Refer to the PC-CDU Reference Manual for a detailed
description of options.

The receiver tracks too few satellites.

= The elevation mask value is too high (above 15 degrees).
Lower the elevation mask. See page 3-15 for information on
setting the elevation mask.

= The survey is conducted near obstructions (tree canopy, tall
buildings, etc.).
¢ Check that the Multipath Reduction boxes have been
enabled.

1. Connect your receiver and a computer and start
PC-CDU. See “Connecting the Receiver and a
Computer” on page 2-19.

2. Click Configuration » Advanced and the Multipath
Reduction tab. Enable the two boxes and click Apply.

* Move to an area free of obstructions, if applicable.

The receiver cannot obtain Code Differential and/or RTK
solutions.

= Incorrect Base coordinates entered.

Specify the correct coordinates for the Base station using
PC-CDU or another suitable field data collection software.

> The receiver is not configured as a Base or Rover.

« If the receiver should function as a Base, ensure it has the
proper configuration. See Chapter 3 for details.
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e If the receiver should function as a Rover, ensure it has the
proper configuration. See Chapter 3 for details.

= The corresponding receiver options may be disabled or expired.

* See “Managing Receiver Options” on page 5-10 for details
on how to check current options.

* Order a new OAF with the desired options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the TPS website for
details

* Refer to the PC-CDU Reference Manual for a detailed
description of options.

= There are not enough common satellites. In order to obtain a
fixed solution, the Base and Rover should track at least five
common satellites.

* Ensure that both the Rover and Base receivers use the
same, and updated, almanac. See “Collecting Almanacs
and Ephemerides” on page 2-26.

* Check the elevation masks of the Rover and Base receivers;
they should be the same. See page 3-15 for information on
setting the elevation mask.

5> A discrepancy exists between the differential standards used at
the Base and Rover receivers.

Ensure the Base and Rover receivers use the same corrections
input/output format:

1. Connect your receiver and a computer and start PC-CDU.
See “Connecting the Receiver and a Computer” on
page 2-19.
2. Click Configuration » Receiver and the Ports tab. Use
the same input/output format for both receivers.
= Poor satellite geometry (PDOP/GDOP values are too high).

Conduct your survey when PDOP values are low.
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= The elevation mask is above 15 degrees.
Lower the elevation mask. See page 3-15 for information on
setting the elevation mask.

& The modem battery is low.

* Attach an external power source to the receiver. See “Using
an Auxiliary Power Source” on page 2-17.

* See “Powering the Receiver” on page 2-14 for details.

= The transmitting and/or receiving antenna may be improperly
connected.

* Check that the radio modem’s antenna is securely and
properly connected to the antenna connector.

* Check that the radio modem’s antenna is undamaged. If
damaged, contact your TPS dealer to replace the antenna.

= The specified baud rate is incompatible with the baud rates the
modem supports.
The baud rate is the rate at which the receiver transmits
differential messages to the modem and vice versa.

Change the baud rate to that which your modem supports.
Refer to the modem’s manual for information.

= The Base and Rover modems use different radio link
parameters.

Configure the Base and Rover radio modems according to the
procedures listed in the applicable section.

* For details on an FH915+ modem, see “Configuring a
Spread Spectrum Radio Modem” on page 3-3.

* For details on a GSM modem, see “Configuring a GSM
Radio Modem” on page 3-7.

= The distance between the Base and Rover is too far.
¢ Close the distance between the Base and Rover.

* Use repeaters to increase radio coverage.
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> There may be a source of radio interference that disrupts radio
communications.
* Change the RF channel (if possible).
» Use a spectrum analyzer to detect the radio characteristics

of the interfering signal and change your system’s
configuration accordingly.

* Remove the source of jamming signal or relocate your
radio antennas (if possible).

The receiver does not start data logging.

> The receiver has no the SD card installed or the memory option
is disabled or expired.
* Check that the card is properly inserted. For details, see “To
install the SD card” on page 2-7.

* Check that the memory option is enabled. For details, see
“Checking the Receiver’s OAF” on page 5-10.

= The receiver’s memory card has no free space.

* Download and/or delete data files to free up space for new
files (see “Downloading Files to a Computer” on page 5-1
and “Deleting Files from the Receiver’s SD Card” on
page 5-8).

* Use the AFRM feature. See “Automatic File Rotation
Mode (AFRM) parameters” on page 3-23.
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Bluetooth Problems

The following are some of the most commonly encountered error
messages and other problems.

BTCONF error message: Can’t find receiver.

= The receiver is turned off.

Ensure the receiver has power and is turned on.

> If using a cable, the cable’s connectors are improperly attached.

¢ Check that the cable connector is attached to the correct
serial port.

* Unplug the cable, then securely and properly reconnect it to
the receiver.
= If using a cable, the cable is damaged.
* Use an undamaged cable.
* Contact your TPS dealer to purchase a new cable.

= The COM port the receiver is attached to differs from the one
selected in BTCONE.

* Ensure that the RS232 cable is attached to the COM port
specified in the BTCONF communication port list.

* See “Bluetooth Module Configuration” on page 2-22 for
details.
> The receiver port used for connection is not in Command mode.

1. Connect your receiver and a computer using a free port
(see “Connecting the Receiver and a Computer” on
page 2-19) and start PC-CDU.

Click Configuration » Receiver » Ports.

3. Change the Input for the serial port used for connection
to “Command”.

| This is the most common cause for this error
% message. Use PC-CDU to double check the settings

for the connection port.
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Troubleshooting

= The settings for Port D may have been changed.
* The settings for Port D are: 115200 baud rate, 8 data bits, 1
stop bit, no parity, and no handshaking.

* Try enabling RTS/CTS handshaking for Port D. Do not
change other settings.

= The corresponding receiver options may be disabled or expired
(serial port D must be enabled).

* See “Managing Receiver Options” on page 5-10 for details
on how to check current options.

* Order a new OAF with the desired options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the TPS website for
details

* Refer to the PC-CDU Reference Manual for a detailed
description of options.
BTCONF error message: Can’t find Bluetooth.
5> The receiver’s Slot 2(C) is turned off.

1. See “Establishing an RS232 Cable Connection” on
page 2-21 to connect the computer and receiver.
. Click Configuration » Receiver » General.
3. In the Turn on/off Slots area, enable the Slot 2(C) check
box.
= The Bluetooth module is linked with another device.
Close the connection with the device, then connect to your
receiver.
= The receiver does not have a Bluetooth module.

* Continue with other configuration/survey functions using a
serial or USB cable.

* Contact your TPS dealer to purchase a Bluetooth enabled
receiver.
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Bluetooth Problems

BTCONF error message: Open COM# port failed: Access is
denied.

= Another application uses the computer port dedicated for
connection.

* Close the application, then re-connect.

» Connect the receiver via another, unused computer port.
After searching for available devices, none are discovered.

= The receiver is not receiving power.
* Check that the receiver is getting power and is turned on.

* Check that the power cable is attached to the port marked
‘6PWR”.

* Unplug the cable, then securely and properly reconnect it to
the receiver.

* If the power cable is damaged, contact your Dealer to
purchase a new cable.
5 The receiver’s Slot 2(C) is turned off.

1. Connect your receiver and a computer using an RS232
cable (see “Establishing an RS232 Cable Connection” on
page 2-21).

Click Configuration » Receiver » General.

3. In the Turn on/off Slots area, enable the Slot 2(C) check
box.

Can see the icon for the receiver’s Bluetooth module on the
computer screen, but cannot connect to it.
= Device security settings probably differ.

* Make sure your Bluetooth enabled devices use the same
security settings.

* See “Bluetooth Module Configuration” on page 2-22,
specifically Figure 2-23 on page 2-25 for details on
changing security settings.
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Troubleshooting

= Bluetooth module settings may have changed.

1. If you changed settings for your Bluetooth module,
remove it from the list of discovered Bluetooth devices
using the Bluetooth manager program (supplied with the
device used to manage the receiver).

2. Repeat the search.

Modem-TPS Problems

The following is the most commonly encountered Modem-TPS
problem.

Modem-TPS cannot connect to the receiver.

= The receiver is turned off.

Ensure the receiver has power and is turned on.

= If using a cable, the cable’s connectors are improperly attached.
* Check that the cable connector is attached to the correct
serial port.
* Unplug the cable, then securely and properly reconnect it to
the receiver.
= If using a cable, the cable is damaged.
* Use an undamaged cable.
* Contact your Dealer to purchase a new cable.

= If using Bluetooth wireless technology, the incorrect port is
selected, or the receiver or computer does not support
Bluetooth.
» Use a computer or receiver that has Bluetooth wireless
technology enabled/installed.

* Check that the computer and receiver use the correct ports
for communication. For the GR-3 receiver, this is port A.
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TX RX LED Blink Pattern on Error Conditions

= The corresponding modem options may be disabled or expired.

* See “Managing Receiver Options” on page 5-10 for details
on how to check current options.

* Order a new OAF with the desired options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the TPS website for
details

* Refer to the PC-CDU Reference Manual for a detailed
description of options.

= The type of radio modem is disabled for detection using
Modem-TPS.

1. If needed, click Cancel on the Connection dialog box or
Stop on the Connecting to device dialog box.

In Modem-TPS, click Tools » Options.

3. Enable the modem type installed in the receiver
connected to the computer. Click Ok.

4. Click File » Connect.

TX RX LED Blink Pattern on
Error Conditions

For internal FH915+ modems: the TX RX LED flashes red.

= A fault condition has been detected.

* Check that the radio modem’s antenna is undamaged.
Contact your dealer to replace the antenna.

* Check that the radio modem’s antenna is securely and
properly connected to the antenna connector.

* Move the antenna/receiver away from conducting objects
(such as, large metal objects).

= The cable is damaged.

* Use an undamaged cable.
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Troubleshooting

Contact your Dealer to replace the cable.

For internal GSM modems: the TX RX LED flashes orange.

= The Rover uses the wrong PIN code, or no PIN code was

selected.
1. In TopSURY, click Job » Config » Survey.
2. Click the “...” (continue) button and press Next to
navigate to the Rover Radio configuration screen.
3. Press Configure GSM.
4. Select the PIN of the Base Station and press OK.

=> An initialization error has occurred.

Check that the radio modem’s antenna is undamaged.
Contact your dealer to replace the antenna.

Check that the radio modem’s antenna is securely and
properly connected to the antenna connector on the
radome.

Obtaining Technical Support

If the troubleshooting hints and tips in this Operator’s Manual fail to
remedy the problem, contact TPS Customer Support.

Before contacting TPS Customer support about any problems with
the receiver, see “Check This First!” on page 6-1 for some solutions
that may fix the issue.

Phone

To contact TPS Customer Support by phone, call:
1-866-4TOPCON (1-866-486-7266)
Monday through Friday
7:00am to 5:00pm, Pacific time
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Obtaining Technical Support

To contact TPS Customer Support via e-mail, use one of the
following electronic mail addresses (Table 6-1).

Table 6-1. Technical Support E-mail

For Questions Related To... Use...
Hardware (receivers, antennas, firmware) hardware @topcon.com
GPS+ and 3DMC psg@topcon.com
OAF options @topcon.com
RTK rtk @topcon.com
PC-CDU pccdu@topcon.com
If in doubt... support@topcon.com

! For quick and effective support, provide a detailed
description of the problem.

When e-mailing TPS customer support, provide the following
information for better, faster service:

1.

5.

The receiver model and configuration settings.

In PC-CDU, click Help » About and click Save to file. Enter a
name for the file and save it to your computer. Attach this file to
the email.

The system/hardware specifications for the computer running
PC-CDU; such as, operating system and version, memory and
storage capacity, processor speed, etc.

The symptoms and/or error codes/messages that precede and
follow the problem.

The activities being tried when the problem occurs. If possible,
include the exact steps being taken up to when the error message
or other problem occurs.

How regularly the problem occurs.

Generally, a customer support representative will reply within 24
hours, depending on the severity of the problem.
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Troubleshooting

Website

The Topcon Positioning Systems website provides current
information about Topcon’s line of products. The support area of the
website provides access to frequently asked questions, configuration
procedures, manuals, e-mail support, etc.

To access the TPS website, use:

wWwWw.topconpositioning.com
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Appendix A

Specifications

This TPS product is a 72-channel GNSS receiver with an internal
radio modem, a Bluetooth® wireless technology module, an optional
GMS module, an optional, removable SD memory card, and a rugged
magnesium housing complete with MINTER and cable connectors.

GPS satellites above 15 degrees in elevation and
adherence to the procedures recommended in this
manual.

@ Performance specifications assume a minimum of 6

In areas of high multipath, during periods of large
PDOP, and during periods of increased ionospheric
activity, performance may degrade.

Use robust checking procedures in areas of extreme
multipath or under dense foliage.

&
&>
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Specifications

Receiver Specifications

The following sections provide specifications for the receiver and its
internal components.

General Details

Table A-1 table lists the receiver’s general specifications.

Table A-1. Receiver General Specifications

Physical
Enclosure Magnesium, IPX 6 extrusion, rainproof
Color Topcon Yellow and Topcon Grey
Dimensions W:156.6 x H:234.5 x D:156.6 mm
Weight 1.78 kg
Antenna Internal
Battery Two external, detachable
Controller External
Mounting 5/8-11, quick disconnect
Seals Silicon (molding in Color)
Keys Two keys:
Power — On/Off
Function — start/stop data logging; switch information
mode.
LEDs Six LEDs:

STAT - satellite and receiver status

REC - record and data status

RX TX — modem status

BT — Bluetooth wireless technology connection status
BATT x 2 — battery status

Environment

Operating
temperature

-20 C° to +50 C° with batteries
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Receiver Specifications

Table A-1. Receiver General Specifications (Continued)

Storage temperature

-20 C° to +35 C° with batteries
-40 C° to +75 C° without batteries

Humidity

95%

Power

External batteries

Li-ion, 3900 mAh, 7.2 V; 2 batteries; detachable

Battery size

132 x 52 x 25 (mm)

Battery weight

165 g (1 battery)

Operating time

Average with
Bluetooth “on” and
12 SVs tracked.

Using new batteries
and operating at
room temperature.

* Modem = off — approx. 16 hours

* 915 receive-only modem — approx. 13 hours

* 915 modem transmitting at 250 mW — approx. 11 hours

* 915 modem transmitting at 1 W — approx. 9 hours

* AA-sized battery shells attached to both battery slots
and modem is off — approx. 2.5 hours

* Urban areas with short distance to cell sites and GSM/
GPRS is on — approx. 12 hours continuous call

External power

1 port

Input voltage 9to 21 V DC (for work)
10 to 21 V DC (for charge battery)
Maximum Charge Current <=2 Amp
Consumption ¢ Modem = off — approx. 3.5 W

Average with
Bluetooth “on” and

* 915 receive-only modem — approx. 4.4 W
* 915 modem transmits at 250 mW — approx. 5.0 W
* 915 modem transmits at 1 W — approx. 6 W

12 SVs tracked.
* Urban areas with short distance to cell sites and GSM/
GPRS is on — approx 4.2 W
Battery charge Connect the AC adaptor to charge the internal battery.
Available run charge when connected to external battery.
Charging time ~6 hours for full charge
On-board Backup battery for timekeeping and almanac data storage;

10 years minimum operation
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Specifications

Table A-1. Receiver General Specifications (Continued)

110
Communication A high speed RS232 serial port (rimmed in black), a USB
Ports port (rimmed in yellow), and an internal Bluetooth

communication port (port D).

Port specifications RS232 Serial Port
Baud rate: 460800,230400,115200(Default),57600,
38400,19200,9600,4800,2400,1200,600, 300
Flow control: RTS/CTS
Length: 7,8 (default)
Sop bit: 1 (default), 2
Parity: None (default), Odd, Even
Bluetooth port
Available
USB port
Version 1.1

Connectors Modem Antenna (BNC or reverse polarity TNC
depending on modem type), PWR, RS232 Serial, USB

MINTER Six external LEDs (see “LEDs” on page A-2 for details)
ON/OFF control input (power button)
Data logging control (FUNCTION button)

Data Features

Up to 20 Hz update rate for real time position and raw
data (code and carrier)

10cm code phase and 0.1mm carrier phase precision
RTCM SC104 version 2.1, 2.2, 2.3, and 3.0 I/O
Multiple Base RTCM

Geoid and Magnetic Variation models

RAIM

Different DATUMs support

Output of grid coordinates

CMR and CMR+ support

Technology

Advanced Multipath mitigation
WAAS
Adjustable PLL and DLL parameters
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Receiver Specifications

Table A-1. Receiver General Specifications (Continued)
NMEA
NMEA version Ver. 2.1, 2.2, 2.3, 3.0 output
Messages GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, RMC,

VTG, ZDA, ROT, GMP

Output interval

1Hz standard; 5, 10, 20Hz optional

DGPS

Correction format

RTCM SC104 Ver 2.1, 2.2, 2.3, and 3.0

RTCM message
type

1, 3,9, 31, 32, 34; user selectable

Process interval

1Hz standard; 5, 10, 20Hz optional

Output interval for
RTCM correction
data

1Hz standard; 5, 10, 20Hz optional

Elevation mask

0 to 90 degrees (independent of data logging)

Multi-base DGPS

Differential correction select mode: Nearest, Mix, Best
(optional)

RTK

Correction format

CMR2/CMR+ (Trimble compatible), RTCM SC104 Ver
2.2,2.3,0r3.0

RTCM message
type

3,18, 19, 20, 21, 22; user selectable

Ambiguity initialize

OTF (L1, L1/L2)

Baseline Length

Up to 50km in the morning and evening.
Up to 32km at noon.

Initialize time

5 seconds to 10 min depending on the base line length and
multipath conditions

Output interval for
CMR/RTCM

1Hz standard; 5, 10, 20Hz optional

Elevation

0 to 90 degrees (independent of data logging)
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Specifications

Table A-1. Receiver General Specifications (Continued)

Solution mode

Delay (synchronization)
Extrapolation (not synchronized)

Process interval

1Hz standard; 5, 10, 20Hz optional

Latency Delay mode — 20 msec to 20 sec (depends on latency
which receives corrections data from base receiver)
Extrapolation — 20 to 30 msec

Raw Data logging The receiver can record raw data at another interval during
RTK operation

Status Fix, Float, DOP, Data Link Status, Modem Latency,
Common satellites, Percentage of fixing

Results RTK coordinates, HRMS, VRMS, Covariance Matrix

Ambiguity fixing Selectable thresholds

level Low: 95%; Medium: 99.5%; High: 99.9%

Survey Modes

Base or Rover

Static

Kinematic (Stop and Go)
RTK (Real-time Kinematic)
DGPS (Differential GPS)
WASS/EGNOS DGPS

Survey Accuracy

Static, Fast Static

For L1+L2 — H: 3mm + 0.5ppm (x baseline length);
V: 5mm + 0.5ppm (x baseline length)

Kinematic, RTK

For L1+ L2, L1 -H: 10mm + 1.0ppm (x baseline length);
V: 15mm + 1.0ppm (x baseline length)

DGPS Post processing: less than 0.25 m (HRMS)
DGPS/RTCM based: less than 0.25 m (HRMS)

Cold Start <60 sec

Warm Start < 10 sec

Reacquisition <1 sec

GR-3 Operator's Manual



Receiver Specifications

GPS Board Details
Table A-2 lists the GPS board’s general specifications.

Table A-2. GPS Board Specifications

Receiver Type (set by activating the proper OAF)

Internal board: GPS: L1 (C/A & P), L2, L2C, L5

GR-3 GLONASS: L1, L2 (both code and phase)
GALILEO: E2-L1-El, E5a

Hardware type: with FH915+ TX/RX/RP

country/region/ with FH915+ TX/RX/RP + GSM

purpose dependent

Tracking Specifications

Standard Channels 72 universal channels (G, GG, GD, GGD)

Optional Cinderella days (see page A-8 for details)

Tracked Signals GPS/GLONASS, L1/L.2 C/A, L5, GALILEO, and P-Code
and Carrier, WAAS/EGNOS

Tracking Functions

Multi-path Code and Carrier
reduction

PLL/DLL setting Bandwidth, order, adjustable

Smoothing interval Code and Carrier

WAAS/EGNOS WAAS optional; EGNOS optional

Data Features

Formats TPS, NMEA, RTCM, CMR, BINEX

Features Up to 20 Hz update rate for real time position and raw
data (code and carrier)

10cm code phase and 0.1mm carrier phase precision
RTCM SC104 version 2.1, 2.2, 2.3, and 3.0 I/O
Multiple Base RTCM

Geoid and Magnetic Variation models

RAIM

Different DATUMSs support
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Specifications

Table A-2. GPS Board Specifications (Continued)

Features Output of grid coordinates
(continued) CMR and CMR+ support
Memory

Internal Memory

SD (secure data) card, removable

Capacity Dependent on capacity of the installed SD/MMC card?,
currently up to 1 GB

Logging Time 53 hours (8 MB, 15sec, L1/L.2, 7 satellites)

Logging Interval 0.05 to 86400 seconds, depending on purchased options

a. SD = secure digital; MMC = mulit-media card

Cinderella days is an option that turns a single frequency, GPS
receiver into a dual-frequency, GPS+GLONASS receiver for 24 hours
every other Tuesday at GPS midnight. Refer to Topcon’s website for
more information and specific Cinderella day dates.

Bluetooth Module Details

Table A-3 lists the Bluetooth wireless technology module’s general

specifications.
Table A-3. Bluetooth Module Specifications
Range up to 10 m (indoor); up to 50 m (outdoor)
Type Class 2
Service classes Miscellaneous

Supported profiles

LM, L2CAP, SDP, SPPP

Frequency Country
Code

North America and Europe
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Receiver Specifications

Internal TPS Spread Spectrum
Modem Details

Table A-4 lists the internal TPS spread spectrum modem’s general

specifications.

Table A-4. Internal TPS Spread Spectrum Specifications

General

Frequency Range
country/region/
purpose dependent

902 to 928 MHz, United States
915 to 925 MHz, Australia

Signal structuring

Frequency-hopping spread spectrum

Hopping pattern 5 per band, user-selectable
Hopping channels 128

Occupied 100 KHz

bandwidth

Frequency FSK, 64 Kbps

modulation

technique

System gain 135dB

Network topology

Point-to-point, Point-to-multipoint

Operation mode

Transmitter, Receiver, Repeater

Protocol

FHO15, FH915+

Transmitter (TX)

Carrier power

250 mW (24 dBm)/1 W (30 dBm), user selectable

Receiver (RX)

Sensitivity

-105 dBm at 10-4 BER

Dynamic range

105 dBm
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Specifications

Table A-4. Internal TPS Spread Spectrum Specifications (Continued)

Data communications

Serial interface

RS232

Serial data rate

9600, 19200, 38400, 57600 bps, user selectable

Effective radio link
rate

9600, 10200, 17000, 51000 bps
User selectable for FH915; automatic selection for
FHO15+

Error correction

FEC (15.7), majority decoding

Antenna Type

Type 1/2 wave articulating whip
Connector Reverse polarity TNC
Gain 2.5 dBi

Optional GSM/GPRS Module Details

Table A-5 lists the internal general specifications for the internal
modem connection for an optional GSM/GPRS module.

Table A-5. GSM/GPRS Module Specifications

Operating systems

EGSM: 900/1800 MHz;
GSM: 850/1900 MHz;

TX power

0.6 W (850 MHz); 2 W (900 MHz); 1 W (1800/1900
MHz);

GPRS

Multi-slot class 8 (4 down; 1 up);

Max BR 85.6 Kbps;

Class B GSM 07.10 multiplexing protocol;
Coding scheme CS1-CS4;

CSD

Max BR 14.4 Kbps;

SMS

MO/MT Text and PDU modes;
Cell broadcast;
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Connector Specifications

Connector Specifications

The GR-3 has one antenna connector for radio transmission/reception
and three port connectors for power and data upload/download.

Radio (Modem) RF Connector

The modem connector (Table A-6) is a reverse polarity TNC
connector for spread spectrum.

Table A-6. Modem Connector Specifications

Modem Type Signal Type Dir Details
Spread Reverse Modem I/O /0 RF/GSM output from
Spectrum polarity TNC modem antenna

Power Connector

Rimmed in red, the power connector (Figure A-1) is a sealed
receptacle, 5 pin, ODU part number G8OF1C-T05QF00-0000.

®
@

Figure A-1. Power Connector

Table A-7 gives power connector specifications.

Table A-7. Power Connector Specifications

Number Signal Name Dir Details

1 Power_INP P 9 to 21 volts DC input
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Specifications

Table A-7. Power Connector Specifications (Continued)

Number Signal Name Dir Details
2 Power_INP P 9 to 21 volts DC input
3 Power_GND P Ground, power return
4 Power_GND P Ground, power return
5 Aux_Power P 9 to 21 volts DC input

Serial C-RS232 Connector

Rimmed in black, the serial RS232 connector (Figure A-2) is a sealed
receptacle, 7 pin, ODU part number G80F1C-T07QC00-0000.

P —

®©
@Q

Figure A-2. Serial RS232 Connector

Table A-8 gives the RS232 cable connector specifications.

Table A-8. RS232 Connector Specifications

Number Signal Name Dir Details
1 Not used
2 GND - Signal ground
3 CTS I Clear to send
4 RTS (0] Request to send
5 RXD I Receive data
6 TXD (6] Transmit data

A-12

GR-3 Operator's Manual




Connector Specifications

Table A-8. RS232 Connector Specifications (Continued)

Number Signal Name Dir Details

7 Not used

USB Connector

Rimmed in yellow, the USB connector is a sealed receptacle, 4 pin
TPS cable connector (Figure A-3).

Figure A-3. USB Connector for GGD Options

Table A-9 gives the USB connector specifications.

Table A-9. USB Specifications

Number Signal Name Dir Details
1 USB_PWR P Bus power input
2 USB D- /0 Data minus
3 USB D+ 170 Data plus
4 GND - Ground
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Notes:
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Appendix B

Safety Warnings

General Warnings

ST

To comply with RF exposure requirements,
maintain at least 25cm between the user and the
radio modem.

Ml

[WARNI

NG )

TPS receivers are designed for survey and survey
related uses (that is, surveying coordinates,
distances, angles and depths, and recording such
measurements). This product should never be used:

Without the user thoroughly understanding this
manual.

After disabling safety systems or altering the
product.

With unauthorized accessories.
Without proper safeguards at the survey site.

Contrary to applicable laws, rules, and
regulations.

L

TPS receivers should never be used in dangerous
environments. Use in rain or snow for a limited
period is permitted.
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Safety Warnings

Battery Pack Warnings

S

Never attempt to open the casing of the detachable
batteries! Lithium-Ion batteries can be dangerous if
mishandled!

S

Do not incinerate or heat battery pack above 212
degrees fahrenheit (100 degrees celsius). Excessive
heat can cause serious damage and possible
explosion.

ull

ARNI

NG )

Tampering with the batteries by end users or non-
factory authorized technicians will void the
battery’s warranty.

* Do not attempt to open the battery pack or
replace it.

* Do not disassemble the battery pack.

* Do not charge in conditions different than
specified.

* Do not use other than the specified battery
charger.

* Do not short circuit.
* Do not crush or modify.
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Usage Warnings

Usage Warnings

o

If this product has been dropped, altered,
transported or shipped without proper packaging, or
otherwise treated without care, erroneous
measurements may occur.

The owner should periodically test this product to
ensure it provides accurate measurements.

Inform TPS immediately if this product does not
function properly.

Only allow authorized TPS warranty service centers
to service or repair this product.
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Notes:
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Appendix C

Regulatory Information

The following sections provide information on this product’s
compliance with government regulations for use.

FCC Compliance

This device complies with Part 15 of the FCC rules. Operation is
subject to the following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including
interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits
for a digital device, pursuant to Part 15 of the FCC rules. These limits
are designed to provide reasonable protection against harmful
interference in residential installations. This equipment generates,
uses, and can radiate radio frequency energy, and if not installed and
used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation.

If this equipment does cause interference to radio or television
equipment reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that
to which the receiver is powered.

* Consult the dealer or an experienced radio/television technician
for additional suggestions.
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Regulatory Information

Any changes or modifications to the equipment not
@ expressly approved by the party responsible for

compliance could void your authority to operate
such equipment.

Community of Europe
Compliance

The product described in this manual is in compliance with the
R&TTE and EMC directives from the European Community.

WEEE Directive

Following information is for EU-member states only:

The use of the symbol indicates that this product may not be treated
as household waste. By ensuring this product is disposed of correctly,
you will help prevent potential negative consequences for the
environment and human health, which could otherwise be caused by
inappropriate waste handling of this product. For more detailed
information about the take-back and recycling of this product, please
contact your supplier where you purchased the product or consult.
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Appendix D

Warranty Terms

TPS laser and electronic positioning equipment are guaranteed
against defective material and workmanship under normal use and
application consistent with this Manual. The equipment is guaranteed
for the period indicated, on the warranty card accompanying the
product, starting from the date that the product is sold to the original

purchaser by TPS’ Authorized Dealers.!

During the warranty period, TPS will, at its option, repair or replace
this product at no additional charge. Repair parts and replacement
products will be furnished on an exchange basis and will be either
reconditioned or new. This limited warranty does not include service
to repair damage to the product resulting from an accident, disaster,
misuses, abuse or modification of the product.

Warranty service may be obtained from an authorized TPS warranty
service dealer. If this product is delivered by mail, purchaser agrees to
insure the product or assume the risk of loss or damage in transit, to
prepay shipping charges to the warranty service location and to use
the original shipping container or equivalent. A letter should
accompany the package furnishing a description of the problem and/
or defect.

The purchaser’s sole remedy shall be replacement as provided above.
In no event shall TPS be liable for any damages or other claim
including any claim for lost profits, lost savings or other incidental or
consequential damages arising out of the use of, or inability to use,
the product.

1. The warranty against defects in a Topcon battery, charger, or cable is 90
days.
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Warranty Terms

Notes:
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Index

A

Adapter, quick disconnect 1-21
AFRM 3-23, 6-8
Almanac 2-1
broadcast data 2-26
collect 4-6
definition 2-26
update 2-26, 5-20, 6-4
Always append to file 3-23
Antenna
radio modem 6-13, 6-14
Antenna reference point 4-4
See also ARP
Antenna, external 1-17
ARP 4-4
Automatic file rotation mode 3-23

Base configuration
RTK 3-14
static 3-14
Base receiver, definition 3-1
Base station 4-2
configuration 3-11-3-19
definition, RTK 3-10
definition, static 3-10
power 1-9
setup 4-2, 4-11
BATT LED 2-14
See also Battery status
Batteries 1-8, 2-9, 2-14
See also Power management
attach 2-15
auxiliary 2-17, 2-18
base station 1-9
battery shell 2-16
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charging 2-9-2-10
charging setup 2-10
detach 2-15
Battery shell 1-10, 2-16
Battery status
charging cradle 1-9
receiver 2-14
via PC-CDU 2-12, 2-14
Beacon, DGPS overview 1-4
Bluetooth 2-20, 2-22
configuration 2-22-2-25
configuration utility 2-4
port B settings 6-10
port D settings 2-20
security 2-24
unable to connect 2-20

Bluetooth connection parameters 3-12

BT LED, blink pattern 1-13
BTCONF 2-4, 2-22
computer requirements 2-4
copies for different purposes 2-5
install 2-5
settings saved 2-5
uninstall 2-§
version requirements 2-4

C

Cables 1-19
alligator clips 1-23
Charging cradle 1-8
powering GR-3 2-17
status button 1-9
Checklist
PP survey configuration 3-2
pre-survey 2-1
receiver setup 4-1
RTK survey configuration 3-2

Index



Index

Clear NVRAM 5-20
Configure
Bluetooth module 2-22
GSM modem 3-7
MINTER 3-21
SS modem 3-3, 3-6
Connect receiver to computer
unable to connect 2-20
using Bluetooth 2-20
using PC-CDU 3-11
using RS232 cable 2-21, 2-22
using USB cable 2-21
Connector 1-17
quick disconnect 1-21
Controller 1-22
Coordinate output 4-12
GSM 4-12
spread spectrum 4-12
Cradle
See Charging Cradle

Data recording auto-start 3-25
Data, save to SD card 2-7
Delete files 5-8
Delimiter 5-14
DGPS 1-4
post-mission 1-4
real-time 1-4
Differential corrections 1-4
LQ field 4-12
overview 1-4
Download
files 5-1-5-7
firmware 5-16-5-20
indicators 5-7
software 2-2

E
EIM 5-14-5-15

LED blink indications 5-15
Elevation mask 3-22

Index

Ephemeris
broadcast data 2-26
definition 2-26
update 2-26
External antenna 1-17

F

FH915 modem 1-10

See also SS modem

RX TX LED 1-12
FHO15 vs FH915+ 3-4
FH915+ modem link rate 3-5
File creation mode 3-23
File name prefix 3-22
Files

delete 5-8

download 5-1-5-7

flash 5-18, 5-19

power board 5-18, 5-20

RAM 5-18, 5-19

select in PC-CDU 5-6
Firmware

files 5-18

load 5-16-5-20

update almanac 2-26
Firmware loader 2-6

See also FLoader
Flash file 5-18, 5-19
FLoader 2-6

computer requirements 2-6

install 2-6

uninstall 2-6

version requirements 2-6
FN key mode 3-14, 3-24

G

GALILEO 1-1, 1-2
GLONASS 1-1, 1-2
GNSS, definition 1-2
GPRS, and SIM card 2-8
GPS 1-1, 1-2

GPS antenna 1-6
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GR-3 kit 4-2, 4-3
cables 1-19
modem antenna 1-20
power supply 1-20
quick disconnect 1-21
SD card 1-20
setup Base 4-2
setup Rover 4-3
tribrach 1-21
GSM modem 1-10
antenna 1-20
configuration 3-7-3-9
information 3-9
RX TX LED 1-13
signal quality 3-9
GSM usage 3-7, B-1
GSM, and SIM card 2-7

Horizontal spacer 1-22, 4-2
part number 1-22, 4-2

|

Information mode
EIM 5-14
sleep 5-16

STAT LED 5-14
Initial data collection dynamic mode
3-25
Install
BTCONF 2-4
FLoader 2-6
Modem-TPS 2-3
PC-CDU 2-2
SD card 2-7
SIM card 2-8
Topcon software 2-2—2-6
USB driver 2-19, 3-10
Internal antenna offset 4-4
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L

LED
battery, charging cradle 1-9
BT blink pattern 1-13
REC blink pattern 1-12
STAT 1-11

Link rate 3-5

Load firmware 5-16-5-20

LQ field 4-13
and RTK Rovers 4-12

M
Memory 1-20, 2-7
size of log files 5-9
MINTER 4-7
configuration 3-21
functions 3-20, 4-7
parameters 3-21, 3-22-3-25
MMC 1-18
See also SD
definition 1-18
Modem configuration
See Radio configuration
Modem frequency range A-9
Modem status 1-12
Modem, types for GR-3 1-10
Modem-TPS 2-3, 3-3
computer requirements 2-3
disconnect 3-3
install 2-3
uninstall 2-4
version requirements 2-3
Multi-frequency 1-1

Navigation message 2-26
See also Almanac
See also Ephemeris, definition
NVRAM
almanac and ephemerides 2-26
clear 5-20
update almanac 2-26

Index
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o

OAF 1-23

update almanac 2-26
Offsets 4-5

horizontal 4-5

internal antenna 4-4

vertical 4-5
OmniSTAR, DGPS overview 1-4
Operating times 1-8
Option authorization file

See OAF

P
PC-CDU 2-2, 2-10, 2-19
computer requirements 2-2
configuration 3-11-3-19,
3-21-3-26
install 2-3
manage power 2-10-2-13
save settings 3-10
uninstall 2-3
version requirements 2-2
Port D settings 2-20
Ports, GR-3 1-16
color of 1-16
Post-mission 1-4
Power 2-14, 2-17
battery depletion 1-8
on/off 2-19
operating times 1-8
status 2-14
with auxiliary battery 2-18
with charging cradle 2-17
Power board file 5-18, 5-20
Power management 2-11-2-13
Power supply 1-20
charging batteries 2-10

Q

Quick disconnect adapter 1-21
measure 4-5

Index

Radio configuration 3-3
RAM file 5-18, 5-19
Real-time 1-4
REC LED
and FUNCTION button 1-13
blink pattern 1-12, 1-13
Receiver modes 5-14
See also EIM
See also Normal Mode
extended 5-14-5-15
sleep mode 5-16
Recording interval 3-22
Rover 4-3
configuration 3-11-3-19
definition, RTK 3-10
definition, static 3-10
kinematic setup 4-11
measure adapter 4-5
RTK survey, LQ field 4-12
setup 4-3
Rover receiver, definition 3-1
RTK 1-5
recommended mode setting 3-16
RTK survey, definition 3-10
RX TX LED and red flashes 6-13, 6-14

S

SD card 1-18, 1-20, 2-7
install 1-18, 2-7

Security parameters 2-24

Serial number 3-14

Set baud rate, 115200 2-20, 3-12,

5-17, 6-10

SIM card 1-18, 2-7
install 1-18, 2-8
requirements 2-8

Sleep mode 5-16

Software 2-2
BTCONF 2-4
FLoader 2-6
Modem-TPS 2-3
PC-CDU 2-2, 3-11-3-19,

3-21-3-26
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Index

SS modem antenna 1-20
SS modem configuration 3-3-3-6
SS modem, FH915 vs FHO15+ 3-4
STAT LED 1-11, 5-14
blink pattern 1-11, 5-14-5-15
EIM 5-14
green 1-11
orange 1-11
red 1-11
Static survey 4-10
Static survey, definition 3-10
Stop and Go survey 4-11
configuration 4-11
definition 4-11
Surveying
static 4-10
stop and go 4-11

T

Test 5-14, B-3

EIM 5-14-5-15
Tribrach 1-21
Tribrach, precision 1-22, 4-2

U

UHF modem 1-10
antenna 1-20
Unable to connect 2-20
Uninstall
BTCONF 2-5
FLoader 2-6
Modem-TPS 2-4
PC-CDU 2-3
USB connection parameters 3-12
USB driver 2-19, 3-10

W

Warnings B-1
battery pack B-2
general B-1
usage B-3
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